Wavelink Avalanche Remote Control
User Guide

rc-ug-30-20091109

Revised 11/9/09
Copyright © 2008 by Wavelink Corporation All rights reserved.

Wavelink Corporation
6985 South Union Park Avenue, Suite 335
Midvale, Utah 84047
Telephone: (801) 316-9000
Fax: (801) 316-9099
Email: customerservice@wavelink.com
Website: http://www.wavelink.com

Email: sales@wavelink.com

No part of this publication may be reproduced or used in any form, or by any electrical or mechanical means, without permission in writing from Wavelink Corporation. This includes electronic or mechanical means, such as photocopying, recording, or information storage and retrieval systems. The material in this manual is subject to change without notice.

The software is provided strictly on an “as is” basis. All software, including firmware, furnished to the user is on a licensed basis. Wavelink grants to the user a non-transferable and non-exclusive license to use each software or firmware program delivered hereunder (licensed program). Except as noted below, such license may not be assigned, sublicensed, or otherwise transferred by the user without prior written consent of Wavelink. No right to copy a licensed program in whole or in part is granted, except as permitted under copyright law. The user shall not modify, merge, or incorporate any form or portion of a licensed program with other program material, create a derivative work from a licensed program, or use a licensed program in a network without written permission from Wavelink. The user agrees to maintain Wavelink’s copyright notice on the licensed programs delivered hereunder, and to include the same on any authorized copies it makes, in whole or in part. The user agrees not to decompile, disassemble, decode, or reverse engineer any licensed program delivered to the user or any portion thereof.

Wavelink reserves the right to make changes to any software or product to improve reliability, function, or design.

The information in this document is bound by the terms of the end user license agreement.
# Table of Contents

**Chapter 1: Introduction**
- Document Assumptions ........................................... 7
- Document Conventions ........................................... 7
- Remote Control Overview ......................................... 8
  - Supported Devices ............................................. 9
  - Features of Remote Control .................................. 9
  - Remote Control Console ....................................... 9
  - Remote Control Server ....................................... 10
  - Remote Control Client ....................................... 10
  - Distribution ................................................... 10
- Remote Control Connections Overview ......................... 10
  - Standard Connection .......................................... 11
    - Connection Sequence ....................................... 11
  - WAN Access VPN, SMS Gateway ............................... 12
    - Connection Sequence ....................................... 12
  - WAN Access VPN, GSM ......................................... 13
    - Connection Sequence ....................................... 14
  - Device Initiated ............................................. 15
    - Connection Sequence ....................................... 15

**Chapter 2: Installing Wavelink Remote Control**
- System Requirements ........................................... 17
  - Server Requirements ........................................ 17
  - Client Requirements ......................................... 18
  - Connection Requirements .................................... 18
- Installing the Remote Control Server ......................... 18
- Installing Remote Control Software Packages ............... 20
  - Avalanche Manager Installation ........................... 21
  - Avalanche MC Installation .................................. 23
    - Creating Software Profiles ............................... 24
    - Installing Software Packages ............................ 24
    - Enabling Software Packages .............................. 25

**Chapter 3: Licensing**
- Types of Licenses ............................................... 27
  - Base Licenses ............................................... 27
  - Base with Maintenance Licenses ............................ 28
- Running the License Server .................................. 28
  - Activating Remote Control .................................. 29
    - Launching the Remote Control License Activator ...... 30
      - Launching the Activator in Avalanche MC .......... 30
      - Launching the Activator in Avalanche Manager .... 30
    - Activating Remote Control .............................. 30
<table>
<thead>
<tr>
<th>Chapter 4: Launching the Remote Control Console</th>
<th>39</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launching from Avalanche Manager</td>
<td>39</td>
</tr>
<tr>
<td>Launching from Avalanche MC</td>
<td>39</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 5: Creating Remote Control Connection Profiles</th>
<th>41</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating New Connection Profiles</td>
<td>41</td>
</tr>
<tr>
<td>Configuring Connection Settings</td>
<td>42</td>
</tr>
<tr>
<td>Configuring Video Mode</td>
<td>44</td>
</tr>
<tr>
<td>Configuring Remote Display</td>
<td>45</td>
</tr>
<tr>
<td>Configuring Logging</td>
<td>46</td>
</tr>
<tr>
<td>Configuring Capture and Record Methods</td>
<td>47</td>
</tr>
<tr>
<td>Configuring Auto-Discovery Settings</td>
<td>48</td>
</tr>
<tr>
<td>Customizing Auto-Discovery Settings</td>
<td>49</td>
</tr>
<tr>
<td>Adding Networks</td>
<td>50</td>
</tr>
<tr>
<td>Removing Networks</td>
<td>51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6: Configuring Client Settings</th>
<th>53</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Configuration Options</td>
<td>53</td>
</tr>
<tr>
<td>Connection</td>
<td>53</td>
</tr>
<tr>
<td>Settings</td>
<td>54</td>
</tr>
<tr>
<td>Logging</td>
<td>55</td>
</tr>
<tr>
<td>Configuring Client Settings From The Console</td>
<td>55</td>
</tr>
<tr>
<td>Configuring Client Settings From The Mobile Device</td>
<td>57</td>
</tr>
<tr>
<td>Clearing Client Settings</td>
<td>58</td>
</tr>
<tr>
<td>Configuring Mobile Devices for Pre-Connect</td>
<td>58</td>
</tr>
<tr>
<td>Pre-connected Tab Actions</td>
<td>58</td>
</tr>
<tr>
<td>Pre-Connection Methods</td>
<td>59</td>
</tr>
<tr>
<td>Excluding Devices From Pre-Connect</td>
<td>59</td>
</tr>
<tr>
<td>Configuring Cellular Carriers</td>
<td>60</td>
</tr>
<tr>
<td>Adding Cellular Carriers</td>
<td>60</td>
</tr>
<tr>
<td>Deleting Cellular Carriers</td>
<td>61</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7: Configuring Server Settings</th>
<th>63</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Connection Server Settings</td>
<td>63</td>
</tr>
<tr>
<td>Configuring SMS Options</td>
<td>65</td>
</tr>
<tr>
<td>SMS Email Gateway Configuration</td>
<td>66</td>
</tr>
<tr>
<td>GSM Modem Configuration</td>
<td>67</td>
</tr>
<tr>
<td>Ports List</td>
<td>69</td>
</tr>
</tbody>
</table>
### Chapter 8: Connecting to Mobile Devices 71

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deploying Remote Control Client to the Mobile Device</td>
<td>71</td>
</tr>
<tr>
<td>Deploying From Avalanche Manager</td>
<td>72</td>
</tr>
<tr>
<td>Deploying From Avalanche MC</td>
<td>72</td>
</tr>
<tr>
<td>Connecting to a Mobile Device</td>
<td>72</td>
</tr>
<tr>
<td>Closing Remote Control Sessions</td>
<td>73</td>
</tr>
<tr>
<td>Sending SMS Messages to Mobile Devices</td>
<td>74</td>
</tr>
<tr>
<td>Sending an SMS Message</td>
<td>75</td>
</tr>
<tr>
<td>Waking a Suspended Device Using SMS</td>
<td>75</td>
</tr>
<tr>
<td>Using Avalanche Update Now (SMS)</td>
<td>76</td>
</tr>
</tbody>
</table>

### Chapter 9: Remote Control Viewer Tasks 77

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing the Mobile Device</td>
<td>78</td>
</tr>
<tr>
<td>Using the File System</td>
<td>78</td>
</tr>
<tr>
<td>Opening the File Explorer</td>
<td>78</td>
</tr>
<tr>
<td>Creating New Folders</td>
<td>80</td>
</tr>
<tr>
<td>Copying Files to the PC</td>
<td>80</td>
</tr>
<tr>
<td>Copying Files from PC to Mobile Device</td>
<td>81</td>
</tr>
<tr>
<td>Running Programs</td>
<td>82</td>
</tr>
<tr>
<td>Opening Files</td>
<td>82</td>
</tr>
<tr>
<td>Viewing Files</td>
<td>82</td>
</tr>
<tr>
<td>Deleting Files</td>
<td>83</td>
</tr>
<tr>
<td>Using Registry Viewer</td>
<td>83</td>
</tr>
<tr>
<td>Viewing the Registry</td>
<td>83</td>
</tr>
<tr>
<td>Creating New Registry Keys</td>
<td>85</td>
</tr>
<tr>
<td>Creating Key Values</td>
<td>85</td>
</tr>
<tr>
<td>Viewing Binary Data</td>
<td>85</td>
</tr>
<tr>
<td>Modifying Key Values</td>
<td>86</td>
</tr>
<tr>
<td>Modifying Binary Data</td>
<td>88</td>
</tr>
<tr>
<td>Deleting Key Values</td>
<td>89</td>
</tr>
<tr>
<td>Exporting Registries</td>
<td>90</td>
</tr>
<tr>
<td>Comparing Registries</td>
<td>90</td>
</tr>
<tr>
<td>Compare Registry to Exported Registry</td>
<td>90</td>
</tr>
<tr>
<td>Compare Registry with Another Device Registry</td>
<td>91</td>
</tr>
<tr>
<td>Using the Process Manager</td>
<td>92</td>
</tr>
<tr>
<td>Accessing the Log File</td>
<td>93</td>
</tr>
<tr>
<td>Viewing the Log File</td>
<td>94</td>
</tr>
<tr>
<td>Configuring Logging</td>
<td>94</td>
</tr>
<tr>
<td>Clearing Log Files</td>
<td>96</td>
</tr>
<tr>
<td>Saving Log Files</td>
<td>96</td>
</tr>
<tr>
<td>Viewing Device Information</td>
<td>97</td>
</tr>
<tr>
<td>Recording AVI Files</td>
<td>98</td>
</tr>
<tr>
<td>Selecting Recording Methods</td>
<td>99</td>
</tr>
<tr>
<td>Recording AVI Files</td>
<td>100</td>
</tr>
</tbody>
</table>
Chapter 10: Configuring Scripts and Scenarios

Generating Scripts .............................................. 115
Configuring the Recording Method ...................... 115
Recording Scripts ............................................. 117
Editing Scripts ................................................ 118
Examples ...................................................... 119
Creating Script Scenarios ................................ 120
Creating Scenarios from the Connection Window .... 120
Adding a New Scenario .................................... 120
Configuring Scenarios .................................... 121
Adding Scripts .............................................. 123
Removing Scripts .......................................... 124
Deleting Scenarios .......................................... 124
Creating Scenarios from the Console .................. 124
Adding New Scenarios .................................... 125
Configuring Scenarios .................................... 126
Adding Scripts .............................................. 127
Removing Scripts .......................................... 128
Deleting Scenarios .......................................... 128
Managing Scripts ........................................... 128
Executing Scenarios ....................................... 129

Chapter 11: Managing Device Skins

Accessing the Keymap Editor .............................. 131
Accessing the Key Map Editor from the Software Package 132
Accessing the Keymap Editor from the Remote Control Console 132
Downloading Skins ........................................... 133
Importing Skin Files ........................................ 135
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating New Skins</td>
<td>135</td>
</tr>
<tr>
<td>Configuring Skin Information</td>
<td>136</td>
</tr>
<tr>
<td>Importing Images</td>
<td>138</td>
</tr>
<tr>
<td>Editing Skins</td>
<td>139</td>
</tr>
<tr>
<td>Configuring Skin Information</td>
<td>139</td>
</tr>
<tr>
<td>Configuring Keymaps</td>
<td>140</td>
</tr>
<tr>
<td>Creating Key States</td>
<td>140</td>
</tr>
<tr>
<td>Configuring Key Actions</td>
<td>141</td>
</tr>
<tr>
<td>Viewing Split Screen</td>
<td>143</td>
</tr>
<tr>
<td>Packaging Skins</td>
<td>144</td>
</tr>
<tr>
<td>Applying Skins</td>
<td>146</td>
</tr>
<tr>
<td>Toggling Skins</td>
<td>147</td>
</tr>
<tr>
<td>Appendix A: Port Information</td>
<td>149</td>
</tr>
<tr>
<td>Index</td>
<td>151</td>
</tr>
</tbody>
</table>
Chapter 1: Introduction

This document contains information about Wavelink Remote Control (Remote Control), an Avalanche plug-in software package.

Document Assumptions

- The user is comfortable in a Windows application environment.
- The user is familiar with the wireless hardware in use, specifically the mobile device.
- The user is familiar with Avalanche Manager or Avalanche MC.

Document Conventions

This document uses the following typographical conventions:

**Courier New**

Any time you type specific information into a text box (such as a file name), that information appears in the *Courier New* text style. This text style is also used for any keyboard commands that you might need to press.

Examples:

Navigate to *C:\deployment*.

Press *CTRL+ALT+DELETE*. 
Remote Control Overview

Remote Control gives you the ability to view and control your Windows CE mobile device from your Avalanche Management Console or Avalanche MC Console and provides real-time images of your mobile device in either Console.

With the Remote Control plug-in, an administrator can remotely diagnose and remedy both applications and device settings, or simply provide assisted guidance for an end-user. This reduces mobile device down-time and increases end-user productivity. Remote Control can be used for presenting software to an audience, rapid data entry and automated software testing.

Remote Control allows multiple instances of itself to run. Each instance can control a separate device. If using a LAN connection for more than one device, each copy of Remote Control must be started and connected to a device before another is started.

The next generation of Remote Control features Wireless Wide Area Network (WWAN) compatibility. This allows you to wake up your mobile device and connect to it, via Remote Control using WWAN technology.
**Supported Devices**

All Windows CE-based mobile devices with an Avalanche 3.50-12 Enabler (and later versions) are supported.

**Features of Remote Control**

The following list describes just some of the features available in Remote Control:

- Ability for 18 frames per second capture speed (depending on the device and the method of communication)
- Support for ActiveSync and wireless LAN
- Capture session to a standard AVI file for distribution
- Create your own scripts to control your CE device including launching applications remotely
- One-click capture of a snapshot of the CE screen to the clipboard or a .bmp, .gif, or .jpeg file
- Auto-discovery of the target devices on a LAN
- Password protection of LAN-connected devices
- Support for custom skins

**Remote Control Console**

The Remote Control package installs on the Avalanche Manager or the Avalanche MC Console and the client portion of Remote Control is downloaded to the mobile device. You can access the Remote Control Console from Avalanche Manager or from the Avalanche MC Console.

The Remote Control Console on the server-side allows you to configure default settings, connection settings, client-side settings, and client-run scenarios.
Remote Control Server

The Remote Control Server facilitates WWAN connections for Remote Control. You can configure server connection settings and set up the SMS e-mail gateway or GSM modem.

Remote Control Client

Once you download the Remote Control package to the mobile device, you can configure a limited number of client-side settings.

The client portion of the Wavelink Remote Control package is deployed as an Avalanche package and runs automatically upon start-up or boot of the mobile device. Remote Control can also be launched from the Programs screen of the Avalanche Enabler.

Distribution

Remote Control is only distributed as an Avalanche package. To obtain the Remote Control software package, contact Wavelink Customer Service.

Remote Control Connections Overview

There are four connection that Remote Control can make with a mobile device:

- Standard Connection
- WAN Access VPN, SMS Gateway
- WAN Access VPN, GSM
- Device Initiated

The following sections provide information about each type of connection and the connection sequence that occurs upon initiated connections. The diagrams provide a visual image of how the connections work and the Connection Sequence provides a step-by-step overview.
Standard Connection

![Diagram of Wavelink Remote Control Standard Connection]

Figure 1-1 Remote Control Standard Connection

Connection Sequence

1. Connection to device is initiated through Wavelink Avalanche Remote Control.

2. Direct TCP/IP connection is made to device.
WAN Access VPN, SMS Gateway

**Figure 1-2** WAN Access Connection

**Connection Sequence**

1. Connection to device is initiated through Wavelink Avalanche Remote Control

2. Remote Control fails to contact the device using TCP/IP.

3. Remote Control contacts the Remote Control Proxy Server requesting a connection to the device.

4. Optionally, the Proxy Server determines if the device can be communicated with via TCP/IP.

5. The Proxy Server sends a connection request to the device through the SMS gateway.

6. The mobile device receives the message and wakes up, if it is sleeping.

7. The mobile device establishes the required connection to the proxy server. This may be accomplished through the following connection methods:
• Wide Area VPN Connection.

• Wide Area Connection using port forwarding.

• Wireless 802.11 LAN connection.
  • Device located at an wireless hotspot.
  • Device located at known wireless network location with internet access.
  • Device located at users home with wireless internet access.

8 The Proxy Server notifies Remote Control that the mobile device is connected and ready.

9 Remote Control communicates with the mobile device through the proxy server.

**WAN Access VPN, GSM**

---

**Figure 1-3 GSM Scenario**
Connection Sequence

1. Connection to device is initiated through Wavelink Avalanche Remote Control.

2. Remote Control fails to contact the device using TCP/IP.

3. Remote Control contacts the Remote Control Proxy Server requesting a connection to the device.

4. Optionally, the Proxy Server determines if the device can be communicated with via TCP/IP.

5. Proxy Server sends a connection request to the device through connected GSM modem.

6. Device receives message and wakes up if it is sleeping.

7. Device establishes the required connection to the proxy server.

   This may be accomplished through the following connection methods:

   • Wide Area VPN Connection
   • Wide Area Connection using port forwarding
   • Wireless 802.11 LAN connection

     • Device located at a wireless hotspot
     • Device located at known wireless network location with internet access
     • Device located at user’s home with wireless internet access

8. Proxy Server notifies Remote Control device is connected and ready.

9. Remote Control communicates with device through proxy server.
Device Initiated

**Connection Sequence**

1. The mobile device connects to the proxy server either manually or by configuration.

This may be accomplished through the following connection methods

- Wide Area VPN Connection
- Wide Area Connection using port forwarding
- Wireless 802.11 LAN connection
  - Device located at an wireless hotspot
  - Device located at known wireless network location with internet access
  - Device located at users home with wireless internet access
2 Remote Control requests a list of connected mobile devices from the proxy server. The device list displays in the \textbf{Pre-Connected} tab.

3 User selects a mobile device to connect to.

4 Remote Control communicates with device through proxy server.
Chapter 2: Installing Wavelink Remote Control

Install the Remote Control software package in Avalanche Manager or the Avalanche MC Console. Once the package is installed, you can configure the Remote Control settings, and deploy the client component and configurations to mobile devices.

This chapter provides the following information:

• System Requirements
• Installing the Remote Control Server
• Installing Remote Control Software Packages

System Requirements

There are three sets of requirements necessary to install and run Wavelink Remote Control:

• Server Requirements
• Client Requirements
• Connection Requirements

Server Requirements

• Windows XP, Vista or Server 2008
• Avalanche SE 4.8.0 or later
  -or-
  Avalanche Mobility Center 4.8.0 or later
• 5 MB of disk space

NOTE Use of Remote Desktop or other terminal services in conjunction with Wavelink Avalanche Remote Control is not recommended.
Client Requirements

- Avalanche Enabler 3.50-12 or later versions
- Windows CE (PocketPC 2003, .NET 4.2, Windows Mobile 5.0, XP, XP embedded devices)
- 200 KB of disk space
- 200 KB of Flash memory

Connection Requirements

Connection requirements are based on how you want to connect to your mobile devices.

- For Lan/Internet Connections. IP connectivity.
- For ActiveSync connections. Microsoft ActiveSync.
- For WWAN Connections. Smartphone with Windows Mobile operating system and the ability to receive SMS messages.

NOTE To obtain the Wavelink Remote Control installation kit, contact Wavelink Customer Support at 1-888-697-9283.

Installing the Remote Control Server

The Remote Control Setup Kit contains the Remote Control Server and the Remote Control software package that you need to run Remote Control.

To install the Remote Control Server:

1. Obtain the Remote Control Setup Kit and place it on the system where you want to install the Remote Control Server.

2. Double-click the Remote Control Setup Kit executable.

   A Welcome dialog box appears.

3. Click Next.
Chapter 2: Installing Wavelink Remote Control

The License Agreement dialog box appears.

4 If you agree to the terms of the license, click I agree and then Next.

If you do not agree, you will not be able to complete the installation.

The Select Destination Location dialog box appears.

5 Click Browse to navigation to the location where you want to install the Remote Control Server. The default location is C:\ProgramFiles\Wavelink\RemoteControl 3.0.

6 Click Next.

The Select Components dialog box appears.

![Select Components dialog box](image)

**Figure 2-1. Select Components**

7 From the drop-down list select which components you want to install.

- **Full Installation.** Installs the entire setup kit which includes the Remote Control Server and the Remote Control software package.

- **Remote Control Server only.** Installs the server only.
• **Remote Control Package only.** Extracts the Remote Control package, allowing you to install the package in Avalanche Manager or Avalanche MC. You should extract this component only if you have another system running the Remote Control Server.

8 Click **Next**.

The *Select Start Menu Folder* dialog box appears.

9 Click **Browse** to navigate to and select the folder where you want to create Remote Control shortcuts in the **Start** menu.

10 Click **Next**.

The *Ready to Install* dialog box appears.

11 Click **Install** to begin the installation.

The Remote Control Setup Wizard installs or extracts the components you selected. When the installation is complete the *Completing the Remote Control 3.0 Setup Wizard* dialog box appears.

12 Click **Finish** to close the wizard.

The Remote Control components are installed on your machine and you can now install the Remote Control software package and begin configuration.

### Installing Remote Control Software Packages

The Remote Control Setup Kit contains the Remote Control software package. Remote Control is an Avalanche software package that you can install in Avalanche Manager or Avalanche MC.

Before you install Remote Control, review the system requirements. For details about Avalanche Manager or Avalanche MC, refer to the appropriate user guide.

This section includes the following information:

• Avalanche Manager Installation

• Avalanche MC Installation
Avalanche Manager Installation

Before installing the Remote Control software package in Avalanche Manager, launch the Avalanche Manager Console and connect to the Avalanche Agent. For detailed information about these tasks, refer to the Avalanche Manager User’s Guide. Once Avalanche Manager connected to an Agent, you can install the Remote Control package.

To install the Remote Control software package:

1. Ensure you are connected to an Avalanche Agent.

2. From the Software Management menu, select Install Software Package.

![Figure 2-2. Installing the Software Package](image)

The Install Software Package Wizard appears.
3 Type the path to the Remote Control software package or click **Browse** to navigate to the package.

4 From the drop-down list, select the software collection to which you want the Remote Control package to belong.

5 Click **Next**.

6 Click **Yes I agree** to agree to the license agreement.

If you click **No, I disagree**, you will not be able to continue the installation.

7 Click **Next**.

The Remote Control software package is installed to the software collection you specified.
Figure 2-4. Completing Installation

8 Click Finish.

You can view the software package in the Tree View of the Avalanche Manager.

**Avalanche MC Installation**

Before you install software packages in the Avalanche MC Console, create a software profile that will contain the Remote Control software package. A software profile is a logical grouping of software packages that are maintained and managed by Avalanche MC. You can create new profiles or copy software from profile to profile as needed.

This section provides information on the following tasks:

- Creating Software Profiles
- Installing Software Packages
- Enabling Software Packages
Creating Software Profiles
You can create software profiles from the Software Profile node in the Navigation window.

To add a software profile:
1. From the Avalanche MC Console, click the Software Profiles node.
2. In the Software Profiles List region, Add Profile.

   An Input dialog box appears.

   ![Figure 2-5. Add Software Profile](image)

3. Enter the name of the profile and click OK.

   The new profile appears in the Software Profiles List region.

Installing Software Packages
Once you create and enable a software profile, you can install the Remote Control software package. This allows you to configure the software package and deploy the client component to mobile devices.

To install a software package:
1. Select the software profile to which you want to add the Remote Control software package.
2. In the Software Packages tab, click Install.

   The Install Software Package Wizard launches.

3. Type the path to the software package in the text box provided, or click [...] to navigate to the Remote Control package.

   This package must have an .ava extension.
4. Click Next.
Chapter 2: Installing Wavelink Remote Control

The License Agreement dialog box appears.

5 Click Yes, I agree to agree to the license agreement.

If you click No, I disagree, you will not be able to continue the installation.

6 Click Next.

The Remote Control software package is installed to the software collection you specified.

7 Click Finish.

**NOTE** Software packages are disabled when you first install them to prevent packages from downloading before they are properly configured.

Once you install the Remote Control package, activate the Remote Control license to ensure complete functionality. For more information about licensing, refer to Chapter 3: Licensing on page 27.

**Enabling Software Packages**

Before you can deploy a software package to a mobile device, you must enable it. Once you enable a software package, it may immediately download to the mobile device.

Wavelink recommends that you configure the Remote Control package before you enable it. This prevents packages from deploying to the mobile device before they are properly configured.

**To enable a software package:**

1 Ensure you have the software profile selected.

2 From the Installed Software Packages region select the package you want to enable and click Enable.

Finish configuring the software package and deploy Remote Control to the mobile devices.

For information about deploying Remote Control, refer to Deploying Remote Control Client to the Mobile Device on page 71.
Chapter 3: Licensing

Remote Control requires a license for full functionality. You can access and configure the Remote Control Console without a license, but you will not be able to communicate with a mobile device.

Remote Control licensing is per-mobile device, meaning that Remote Control can manage one mobile device for each license.

This chapter provides the following licensing information:

- Types of Licenses
- Running the License Server
- Activating Remote Control
- Changing the License Server
- Verifying Licenses

Types of Licenses

Remote Control requires one Remote Control license for each mobile device to which you want to connect.

NOTE To obtain any Remote Control license, please contact Wavelink Customer Service.

There are two types of licenses you can purchase for Remote Control:

- Base Licenses
- Base with Maintenance Licenses

Base Licenses

A base license authorizes you to the version of Remote Control that you purchased and any builds associated with that version. For example, if you purchased a Remote Control 3.0 license, then you are entitled to use 3.00-xx Avalanche builds. If you want to use the features available in the 3.10-xx
Remote Control, then you must either buy a 3.1 base license for your mobile devices, or you must purchase a maintenance license for your devices. A Base license provides for minor upgrades and code changes, but does not allow major upgrades and updates to Remote Control. Base licenses do not expire, but they do not allow you to upgrade to a greater version of Remote Control.

**Base with Maintenance Licenses**

A base with maintenance license allows you to upgrade Remote Control when new major versions of Remote Control become available. For example, maintenance allows you to upgrade from Remote Control 3.x to Remote Control 4.x. Maintenance is valid through a specific date. After the expiration date, if you upgrade Remote Control, it will revert to operating in demo mode.

**Running the License Server**

License Server is a Wavelink application that runs on a host system and as part of Avalanche MC and the Avalanche Manager software packages. The License Server is responsible for supplying licenses to mobile devices that are using Remote Control.

When a Mobile Device Agent (Avalanche Manager) or a Mobile Device dServer (Avalanche MC) detects that a device is running Remote Control, it sends a request to the License Server for that particular type of license. The License Server then sends down the Remote Control license to the requesting Agent. If a license expires or is released, the license returns to the pool of licenses in the License Server until it is sent to an agent upon request.

The License Server is a service that starts automatically. However, if for some reason it is not running, the mobile device will not be able to receive licenses.

The License Server operates on port 7221. For the License Server to function properly, this port needs to be open or not blocked by firewall.

**Running the License Server from the Command Line**

Use the following switches to run the license server from a command prompt:

- `-c` Run as a console application, not as a service
- `-i` Install the license server
Chapter 3: Licensing

Activating Remote Control

After installing the Remote Control software package, you need to activate it with a valid license code. This code uses a technique called nodelocking, in which Remote Control is licensed only for a specific computer, or node, on your network. A node is defined as several specific system attributes that, in combination, uniquely distinguish it from any other system in your organization.

Once a license for Remote Control is activated and associated with a specific node (nodelocked), you cannot move that license to another node. If you want to move the license, you need to contact Wavelink Customer Service.

This section provides the following information about activating your Remote Control license:

• Launching the Remote Control License Activator
• Activating Demo Mode
• Activating Remote Control Licenses

- q  Stop the license server
- s  Start the license server
- u  Uninstall the license server
- l <level>  Logging level
  • d = debug
  • n = notice (default)
  • w = warn
  • e = error
  • c = critical
Launching the Remote Control License Activator

Wavelink provides a license Activator packaged with Avalanche MC and with the Remote Control package. You can access this Activator to install licenses for the Remote Control package.

Once you launch the Activator, the methods you use to run the activator and install licenses are the same whether you are using Avalanche MC or Avalanche Manager.

**Launching the Activator in Avalanche MC**

You can launch the activator from the Start menu or from the Remote Control software package if you are using Avalanche MC.

**To launch the activator for Avalanche MC:**

- Select Start > Programs > AvalancheMC > Activator.

- Or-

- Select the Remote Control software package in the Software Profile tab and click Configure. From the dialog box that appears, select Activator.

**NOTE** For more information about Avalanche MC, refer to the *Wavelink Avalanche Mobility Center User’s Guide.*

**Launching the Activator in Avalanche Manager**

If you are installing the Remote Control software package in Avalanche Manager, you can launch the activator from the configuration menu of the software package.

**To launch the activator for Avalanche Manager:**

- From the Tree View in Avalanche Manager, right-click the software package and select Activator from the menu.

**Activating Remote Control**

When you activate Remote Control, a license file called `wavelink.lic` installs on your system. This file provides the license information Remote Control needs to operate. There are three methods to activate Remote Control licenses:
• Activating Automatically
• Activating Manually
• Importing Licenses

**Activating Automatically**
If Avalanche Manager or Avalanche MC Console resides on a system that has Internet access, you can use the automatic license activation. When you automatically activate licenses, Avalanche Manager or Avalanche MC connect with a secure Wavelink Web site to verify your license and nodelock and a license file is sent to your host system. The license file called `wavelink.lic` is installed on your system, which provides the information the product needs to operate.

**To activate Remote Control:**
1. Obtain the Remote Control product licensing code from Wavelink.

---

**NOTE** You receive this information in an e-mail from Wavelink upon purchasing Wavelink Remote Control. Contact Wavelink Customer Service if you have not received this e-mail.

2. Access the Wavelink Activator from the **Start** menu or from the **Remote Control Configuration** menu.
From the Product drop-down menu, select Remote Control 3.0.

Type your license number for this installation in the Product License text box.

Click Activate.

Remote Control connects with a secure Wavelink Web site, your license and nodelock are verified, and a license file is sent to your host system. A new dialog box appears that specifies your licensing information and asks if you want to save this information for this installation.

Click Yes to accept the license file and activate your installation.

**Activating Manually**

If your server is not connected to the internet or if you have problems with the automatic activation, you can activate your license manually.

To activate your license manually you need the following information:

- **NodeLock for the machine.** Find this information in the Wavelink Activator found in the Start menu.
• **Product License.** Find this information in the e-mail you receive from Wavelink upon purchasing Avalanche MC.

• **e-mail Address.** You need a valid e-mail address. The license file will be sent to this e-mail address.

**To activate Remote Control:**

1. Gather the information needed.


3. Enter the **Hardware Node Lock** and the **License** in the text boxes.

4. Select the product you are activating.

5. Enter your registration information in the **Registration** region. (This step is optional.)

6. Enter a valid e-mail address.

7. Click **Activate License.**

   When you click **Activate License,** the Wavelink activation server verifies the information you entered and then sends an e-mail containing the `wavelink.lic` file to the address you entered.

8. Check your e-mail to ensure you received the `wavelink.lic` file and then follow the steps to import a license file.

**Importing Licenses**

If you already have a license file for Avalanche MC or you have received the `wavelink.lic` file using the manual activation method, you can activate the license by importing it into the Activator. You can import multiple license files or consolidate several files.

**To import a license:**

1. Access the Wavelink Activator from the **Start** menu or from the Remote Control Configuration menu.
2 Click **Browse** and navigate to the location of the `wavelink.lic` file.

3 Select the `wavelink.lic` file and click **Yes**.

4 In the **Wavelink Activation** dialog box, click **Close**.

**Activating Demo Mode**

If you are installing Remote Control for demonstration purposes, you can run the product in demo mode. Demo mode gives you full Remote Control functionality on two mobile devices for 30 days.

**To activate demo mode:**

1 Access the Wavelink Activator from the **Start** menu or from the default Remote Control Configuration menu.

   The **Wavelink Activation** dialog box appears.
Changing the License Server

You change the License Server and port number from the Licenses tab of the Remote Control Console. For details about launching the Remote Control Console, refer to Chapter 4: Launching the Remote Control Console on page 39.

To change the License Server:

1. Launch the Remote Control Console and select the Licensing tab.

2. In the License Server text box, enter the name of the License Server, name you want to use.

   You can enter the name of the License Server, the name of the computer on your network running the License Server, or the IP address of the computer running the License Server.

3. In the Port text box, enter the port number you want the License Server to run on.
4 Click **Save** to save your changes.

**Verifying Licenses**

From the **Licenses** tab of the Remote Control Console, you can verify that the License Server is running. You review the total number of licenses currently in use.

**To verify licenses:**

1. Launch the Remote Control Console and select the **Licensing** tab.

2. In the **Verify Connection** region, click **Verify**.

![Figure 3-4. Verifying Connections](image-url)
If the License Server can be contacted, the **Status** field displays the message **“Server OK”**.

If the License Server can not be contacted, the **Status** field displays the message **“Could not verify server”**.

In the **Licenses** region, you can view the number of licenses that are currently in use.
Chapter 4: Launching the Remote Control Console

Use the configuration options in the Remote Control Console to customize the way you connect to and view your mobile devices. You can access the Remote Control Console through Avalanche Manager or Avalanche MC. The console is the same whether you launch it through Avalanche Manager or Avalanche MC.

**NOTE** If you do not have Remote Control licenses, you will have access to the Remote Control Console. However, you will not be able to connect to or control mobile devices.

This chapter provides information about launching the Remote Control Console including:

- Launching from Avalanche Manager
- Launching from Avalanche MC

**Launching from Avalanche Manager**

You can launch the Remote Control Console from the Tree View of the Avalanche Manager.

**To launch the configuration window:**

1. In the Tree View of Avalanche Manager, navigate to the software collection in which you installed Wavelink Remote Control.
2. Right-click the Remote Control package.
3. Select **Configure Package > Remote Control Console**.

The Remote Control Console appears.

**Launching from Avalanche MC**

If you are using Avalanche MC, you can launch the Remote Control Console from Software Profiles or from the **Mobile Device Inventory** tab.
To launch from a Software Profile:
1  Select the Software Profile that contains the Remote Control package you want to configure and click the Software Packages tab.
2  Select the Remote Control package and click Configure.
   You can also right-click the Remote Control package and click Configure.
   The Configure Software dialog box appears.
3  From the text box, select Remote Control Console and click OK.
4  In the dialog box that appears, enter the server address and port number of the Remote Control Server and click OK.
5  If the Console can connect to the Remote Control Server, the Remote Control Console launches.

To launch from the Mobile Device Inventory tab:
1  Navigate to the Mobile Device Inventory tab and double-click the mobile device to which you want to connect Remote Control.
   The Mobile Device Details dialog box appears.
2  Click the Device Control tab.
3  Double-click the Communication Set icon.
   The Remote Control Console launches in a separate window.
Chapter 5: Creating Remote Control Connection Profiles

Remote Control allows you to configure connection profiles. Connection profiles are collections of connection settings that you can use to connect to your mobile device. You can apply profiles to devices depending on what type of connection you want to make with the device.

When you create profiles, you select one profile to use as a default profile. The default profile is used for any mobile devices connections that you do not assign a specific profile.

Configuring profile settings consists of the following tasks:

- Creating New Connection Profiles
- Configuring Connection Settings
- Configuring Remote Display
- Configuring Logging
- Configuring Capture and Record Methods

Each of these tasks is performed from the Profiles tab of the Remote Control Console. For information about launching the Remote Control Console, refer to Chapter 4: Launching the Remote Control Console on page 39.

Creating New Connection Profiles

You can create new connection profiles or modify the profiles that already exist in Remote Control.

To create a new profile:

1. Open the Remote Control Console and click the Profiles tab.

2. Select File > New.

A new profile appears in the list box. You can now configure the settings to connect to a mobile device.
NOTE If you want to modify an existing profile, select the profile you want to modify and edit the settings.

Configuring Connection Settings

You can create and configure new connections for Wavelink Remote Control based on the type of connection between the mobile device and the PC.

Remote Control supports the following communication methods (listed from slowest to fastest):

- Serial over ActiveSync
- LAN over ActiveSync
- LAN or WAN direct

When you use the LAN communication method, Remote Control broadcasts a short message on the network once every second to find the CE server side without having to know the server IP address in advance. All of the devices that respond display in the Connections list. Once a connection is made, no more broadcast messages are sent. This method will not be able to get past routers, but is convenient when using dynamic IP addresses.

The WAN setting uses the provided IP address to connect to the target CE server even across the internet (not through firewalls). To get through firewalls, allow ports 1899 and 1903 to operate.

When using a direct communication method, ensure ActiveSync is not using the same communication method. Uncheck the settings in the ActiveSync Configuration dialog for serial or USB connections.

It is preferable to use a direct communication method, if possible.

To configure the connection settings:

1 In the Profiles tab of the Remote Control Console, create a new profile or select the profile you want to configure.
Figure 5-1. Configuring the Profiles Tab

2 From the Connection Type drop-down list, select the connection method you want to use to connect to a mobile device.

3 In the Timeout text box, enter the number of seconds you want to elapse before the Remote Control stops attempting to connect and times out.

4 Configure the settings for Video Mode. For more details about configuring video mode refer to Configuring Video Mode on page 44.

5 If you want to use this profile as the default profile, enable the Use as Default option.
**NOTE** There can only be one profile per connection type (ActiveSync, Remote Control Server, TCP/IP) set as the default profile at a given time. The default profile will be applied to every Remote Control connection that does not specifically state which profile to use.

---

6 Enable the **Queue events** option to send groups of requests to the mobile device rather than sending each request as a single package.

7 If you want to force the device screen to display in grayscale, enable the **Force grayscale on pallet device(s)** option.

**NOTE** This option only applies to devices that have a video controller using a 8 bit per pixel pallet display. This option does not affect any device using more than 256 colors.

---

8 Click **Update** to update the profile with the configuration changes or continue configuring the profile.

---

**Configuring Video Mode**

Video mode types allow you to set the amount of data required for screen updates. There are three types of video mode you can select:

- **Std (Standard)**. Uses the legacy video compression scheme.

- **Image (jpeg based)**. Uses JPEG based image compression. The JPEG format is a lossy compression. A lossy compression method is one where compressing data and then decompressing it, retrieves data that may not appear exactly as it did on the mobile device. The amount of compression affects the quality of the screen image. The amount of compression is expressed in the **Quality** text box.

- **Default**. This is the default mode the standard mode.

The Image video mode is useful for wide area networks where reducing the amount of data transmitted outweighs the quality of the image. Screens that contain natural images compress very well and do not visibly show the compression artifacts that more textual based screens do.
You can also configure video mode from the Remote Control Viewer. For more information, refer to Chapter 9: Remote Control Viewer Tasks on page 77.

To configure video mode:

1. From the Video Mode drop-down list, select the video mode you want to use.

2. If you select to use the Image Video Mode, you need to enter the amount of compression in the Quality text box.

   1 = Poor quality  30 = Remote Control Default  99 = High quality

**Configuring Remote Display**

You can configure the way you want the remote mobile device to display in the Remote Control Viewer. You can configure how large the image is, how often you want to refresh the screen and whether to show a skin of the device to which you are connected.

To configure the Display/Skin:

1. In the Profiles tab of the Remote Control Console, select the profile you are configuring from the profile list.

2. From the drop-down list in the Display/Skin region, select the Refresh Rate.

   The refresh rate can range from 1 to 18 frames per second. Your selection is dependent on the speed of the mobile device and the communication method you are using. Select the best setting for your usage that does not impact the mobile device CPU too heavily and allows for reasonable screen updates.

3. From the drop-down list in the Display/Skin region, select the Scale.

   You can magnify the screen display from .5X-4X or select Auto for the autoscale option. If you use the autoscale option, the display will be sized to fit in the window you have open.

4. If you want to allow a selected skin to display, enable the Show Skin option and select skin you want from the drop-down list.
If you want Remote Control to auto-detect which skin to display, select the AutoDetect option.

For more information about skins, refer to Chapter 11: Using Skins on page 131 and Chapter 11: Managing Device Skins on page 131.

5 Click Update to update the profile or continue configuring the profile.

**Configuring Logging**

The Remote Control logging feature tracks the connections and actions of Remote Control. This information is saved to a log file which you can access for informational or trouble shooting purposes.

You can configure the level at which Remote Control logs information and the size of the log file. The maximum size determines the size the log file can reach before Remote Control creates a new log file. The new log file does not override the previous log file.

For information about viewing the log file, refer to Accessing the Log File on page 93.

Logging levels include:

- **Critical.** Indicates errors that cause Remote Control to fail to start.
- **Error.** Indicates errors that are caused by configuration and/or communication problems.
- **Warning.** Indicates possible operational problems.
- **Informational.** Documents the flow of operation.
- **Debug.** Used to diagnose program malfunctions or communication problems.
- **None.** No information is captured.

**To configure logging:**

1 In the Profiles tab of the Remote Control Console, select the profile you are configuring.
2 From the Level drop-down list in the Logging region, select the level you want to log Remote Control events.

3 In the Max Size text box, enter the size of the log file.

4 Click Update.

**Configuring Capture and Record Methods**

There are three methods to capture screen images from the mobile device:

- **File.** This option allows you to specify a file location for the image.
- **Clipboard.** This option places the image on the clipboard.
- **One-click.** Use this option to click once and send the screen capture to a previously specified file format. The file name is created automatically based on the current time and date. The file is placed in the default C:\_AVA\localhost\MAIN\[Device Name]\WLRMTCTL\APPS\WLRMTCTL\RECORDED_DATA folder.

In addition to capturing screen images, you can also use Remote Control to record AVI files. The AVI file is saved in the C:\_AVA\localhost\MAIN\[Device Name]\WLRMTCTL\APPS\WLRMTCTL\RECORDED_DATA folder.

The AVI file can then be played on any program compatible with the AVI video file format, such as Windows Media Player.

**To configure capture and recording methods:**

1 In the Profiles tab of the Remote Control Console, select the profile you are configuring.

2 In the Capture region, select the Screen Capture method based on how you want to capture screen images.

3 From the Format drop-down list, select the format in which you want to save your screen captures.

4 From the Recording Method region, select the method you want to use to record actions.
• Enable the **Script Events** option if you want to save your actions as a script file.

• Enable the **AVI Video** option if you want to save your actions as an AVI recording.

5 Enable the **Show Mouse Cursor** if you want to display the mouse in the AVI file or script.

6 Click **Update** to update this profile with the configuration changes.

The connection profile is complete. You can create and modify other connections profiles based on your needs.

For information about scripting, refer to *Generating Scripts* on page 115.

For information about viewing recordings and screen captures in the Remote Control Console, refer to *Executing Scenarios* on page 129.

### Configuring Auto-Discovery Settings

If you are working with devices on a LAN, Remote Control can auto-discover which devices are in listening range. Once Remote Control discovers the devices on your LAN, you can connect to these devices. You can also configure Remote Control to discover mobile devices across subnets and update the Remote Control database with the results.

Each device can optionally be configured with a password to protect it from unauthorized access. The password is configured in the **Client Configuration** dialog box. For more information on configuring the password, refer to *Chapter 6: Configuring Client Settings* on page 53. Once the password is confirmed, Remote Control connects to the device.

This section provides the following information:

• Customizing Auto-Discovery Settings

• Adding Networks

• Removing Networks
Customizing Auto-Discovery Settings

You can customize the way Remote Control automatically discovers mobile devices by configuring the discovery parameters in the Autodiscovery Settings dialog box. Select the AutoDiscovery tab and from the Settings menu, select Set Discovery Parameters to access the dialog box. From this dialog box you can configure the following:

- **Enable Discovery.** This option enables auto-discovery for Remote Control.

- **Enable Local Area Broadcasts.** This option enables or disables the Local UDP broadcast method of auto-discovery. UDP is a connectionless protocol that runs on top of IP networks, offering a direct way to send and receive datagrams over an IP network. It is used primarily for broadcasting messages over a network.

- **Discovery Interval.** This option sets how often broadcasts are sent. If this interval is set too low, it may appear that there is a large series of address resolution protocols (ARP storm) on the network. This can cause network traffic to be temporarily disrupted. If you have diagnostic tools running on the network, you should set this interval above the threshold for the ARP storm warning.

- **Use Fast Search.** This option skips querying each device on the network. It sends out the discovery request to xxx.xxx.xxx.255. This works quickly but does not provide complete device detection. This option is not enabled by default. When it is disabled, each device receives the discovery request. This results in a longer discovery time but with more accurate results.

- **Device wait time.** This option determines how long the Remote Control Console waits for a device to respond to a request before attempting to contact the next device.

- **Threads.** This option determines how many threads can be processed during the broadcast.

- **Add Networks.** From this region, you can enter new networks where you can search for devices. For detailed information about adding and removing networks, refer to *Adding Networks* on page 50.

**To configure auto-discovery settings:**

1. From the Remote Control Console, click the AutoDiscovery tab and select Settings > Set Discovery Parameters.
The *Autodiscovery Settings* dialog box appears.

![Autodiscovery Settings Dialog Box]

2 Configure the **Local Area Broadcast** settings.

3 Configure the first **Search Network** region settings.

**NOTE** For details about each setting, refer to *Customizing Auto-Discovery Settings* on page 49.

4 Click **OK**.

The discovery parameters are saved and the *Autodiscovery Settings* dialog box closes.

**Adding Networks**

To allow discovery across subnets, you can add networks to the **Add Networks** region of the *Autodiscovery Settings* dialog box. When you add a
network, you set the first three octets of the network address. Then Remote Control sends requests to addresses xxx.xxx.xxx.1 through xxx.xxx.xxx.254 attempting to contact mobile devices at each of those addresses.

The auto discover feature runs at a constant set interval. If you add a new network, the network is added to the network list and is searched when the next auto-discover interval is reached.

To add a network:

1. From the Remote Control Console, click the Autodiscovery tab.
2. Select Settings > Set Discovery Parameters.
3. In the Add Networks region, click Add.

   The Add Network dialog box appears.

   Figure 5-3. Add Network

4. Enter the first three octets of the network address.
5. Click OK.

   The address is added to the Add Networks region.

Removing Networks

If you no longer need to search a network, you can remove it from the Add Networks region.

To remove a network address:

1. From the Remote Control Console, click the Autodiscovery tab.
2. Select Settings > Set Discovery Parameters.
3. In the Add Networks region, select the network address you want to remove and click Delete.
A Remote Control dialog box appears.

Click Yes to confirm that you want to delete the network.
Chapter 6: Configuring Client Settings

You can configure your mobile device connection settings in the Client Config tab. These settings are deployed to the mobile device when the package is downloaded. If enabled to do so, you can also configure a limited number of settings from the mobile device.

This chapter provides information about configuring client settings from both the Remote Control Console and from the mobile device and includes the following information:

- Client Configuration Options
- Configuring Client Settings From The Console
- Configuring Client Settings From The Mobile Device
- Clearing Client Settings
- Configuring Mobile Devices for Pre-Connect

Client Configuration Options

This section provides information about the Remote Control client configuration options available on the Client Settings tab. There are three areas on the Client Settings tab that you can configure:

- Connection
- Settings
- Logging

Connection

You can configure the following connection settings:

- **Type.** Select to use either TCP/IP or ActiveSync to connect to mobile devices.
- **Password.** Enter a password to require Remote Control users to provide a password before connecting to a mobile device.
• **Policy.** Select how Remote Control notifies the mobile device user that Remote Control is establishing a connection.

  • **Silent** option indicates that the user will not be notified.
  
  • **Notify** option indicates that the user will see a text window on their device letting him know that a connection has been established.
  
  • **Prompt-Allow** option will provide the user with a prompt to allow or deny the connection. If the user does not respond, the connection will be allowed.
  
  • **Prompt-Deny** option will provide the user with a prompt to allow or deny the connection. If the user does not respond, the connection will be denied.
  
  • **Policy seconds.** Select how long the notification or prompt will be displayed. If you select **Prompt-Allow** or **Prompt-Deny**, this is how long Remote Control will wait before establishing or denying the connection.

• **Sleep While Connected.** Enable this option to allow the mobile device to enter sleep mode while connected to Remote Control. If you do not enable this option, Remote Control will not allow the mobile device to enter sleep mode while connected.

• **Pre-Connect to Server.** Enable this option to configure the device to always pre-connect to the Remote Control Server.

• **Connect on ActiveSync.** Enable this option to configure the device to connect to the Remote Control Server when connected through ActiveSync.

**Settings**

You can customize the way Remote Control connects to and interacts with the mobile device using the following connection options:

• **Allow Client Configuration.** Enable this option to grant client configuration control to the mobile device user. This allows the user to configure the Remote Control client from the mobile device. When the mobile device user has configuration control, any changes you make in the **Client Settings** tab from the Remote Control Console will not deploy to the device. To regain Client Configuration setting control from the Remote
Control Console, you must disable this option and redeploy the settings to the mobile device.

- **Disable Client Exit.** Enable this option to prohibit the mobile device user from exiting the Remote Control application.

**Logging**

Logging allows you to track the connections and actions of Remote Control to the mobile device. This information is then saved to a log file which you can access for informational or trouble shooting purposes. Device logs appear in the **Device Logs** tab of the Remote Control Console. Logging settings include:

- **Log Level.** Logging levels include:
  
  - **Critical.** Indicates errors that cause Remote Control to fail to start.
  
  - **Error.** Indicates errors that are caused by configuration and/or communication problems.
  
  - **Informational.** Documents the flow of operation.
  
  - **Warning.** Indicates possible operational problems.
  
  - **Debug low.** Used to diagnose program malfunctions or communication problems.

- **Max Size.** Configure the maximum size that the log file can reach before creating a new log file. New log files do not override previous log files.

**Configuring Client Settings From The Console**

Once you review the configuration options and determine the way you want to configure the Remote Control client settings, you assign the configurations in the **Client Settings** tab.

**To configure client settings:**

1. Launch the Remote Control Console.

2. Click the **Client Settings** tab.
3 From the **Connection Type** drop-down menu, select the connection method.

4 Enter a **Password** if you want to require a password before connecting to a mobile device.

5 Enable the **Require for LAN** option if you want to require the user to input a password before connecting to a device over a LAN connection.

6 Enable options in the **Connection** region based on how you want to configure your clients. For detailed information about each option, refer to *Configuring Client Settings From The Console* on page 55.
7 Configure the log level and the maximum size of the log file.

8 Click Update.

9 Deploy the settings to the mobile device.

For information about deploying Remote Control settings, refer to Deploying Remote Control Client to the Mobile Device on page 71.

### Configuring Client Settings From The Mobile Device

Before you can configure client settings from the mobile device, you must enable the Allow Client Configuration option in the Client Settings tab of the Remote Control Console. This allows the mobile device user to configure passwords, connection types and other client-side configuration options from the mobile device. If you disable the Allow Client Configuration option, the mobile device user will not be allowed to access the client information on the mobile device.

For more information about enabling the Allow Client Configuration option, refer to Configuring Client Settings From The Console on page 55.

**To configure client settings from the mobile device:**

1 Launch the Remote Control application on the mobile device.

2 From the File menu, select Configure.

   The Configure dialog box appears.

   **NOTE** If the Allow Client Configuration option is not enabled, the Not Available dialog box appears. You will not be able to access client settings.

3 From the drop-down menu, select your connection type.

4 Enter a password in the available text box if you want to require the user to input a password before creating a Remote Control session.

5 Enable the Allow Sleep while connected option to allow the mobile device to enter sleep mode while connected to Remote Control.

6 Click OK.
The Remote Control application is updated with the new client settings.

**Clearing Client Settings**

You can clear all client configuration settings using the **Clear Client Settings** option in Remote Control Viewer. When you select this option, all your client configurations are removed, including anything that was configured on the mobile device. This option is useful if you have set the **Allow Client Config** option and no longer have access to modify the client settings from the Remote Control Console.

**To clear client settings:**
- From the **Tools** menu in the Remote Control Viewer, select **Clear Client Settings**.

**Configuring Mobile Devices for Pre-Connect**

You can assign mobile devices to pre-connect directly to the Remote Control Server. This allows you to connect to a mobile device that is behind a firewall. Normally mobile devices behind a firewall cannot be reached because the firewall blocks access to the mobile device and the mobile device IP address is unreachable.

Pre-connected devices are devices that are connected to the Remote Control Server, but are not connected to a Remote Control session. Pre-connected devices remain in the **Pre-connected** tab until a Remote Control session is initiated.

This section provides information about the following topics:
- Pre-connected Tab Actions
- Pre-Connection Methods
- Excluding Devices From Pre-Connect

**Pre-connected Tab Actions**

Pre-connected devices are listed in the **Pre-Connected** tab until a Remote Control session is initiated. From the **Pre-Connected** tab, you can perform the following actions
• **Connect.** This option connects a selected mobile device to a Remote Control session. Once a mobile device is connected to a Remote Control session, it is removed from the Pre-Connected tab.

• **Disconnect.** This option disconnects the mobile device from the Remote Control Server and removes the device from the Pre-Connected tab. However, if the mobile device is configured (through the Client Config tab) to automatically pre-connect, the mobile device will reconnect to the Remote Control Server immediately and again appear in the Pre-Connected tab.

• **Refresh.** This option updates the device list in the Pre-Connected tab with any new devices from the Remote Control Server.

### Pre-Connection Methods

There are two ways to pre-connect a mobile device to the Remote Control Server:

• **From the mobile device.** Use the Connect option on the client status screen of the mobile device. For this option to work, the mobile device user must be actively using the mobile device and have access to the Remote Control status screen. In some instances, this is not possible because the device can be locked into a single application program. The mobile device does not need to be configured for pre-connect to use this option.

• **From the Remote Control Console.** When you set pre-connect from the Remote Control Console, you configure the mobile device to always pre-connect. This forces the mobile device to pre-connect to the Remote Control Server upon startup. The mobile device will automatically reconnect to the Remote Control Server once a Remote Control session is disconnected or lost. For instructions on how to enable pre-connect option, refer to Configuring Client Settings From The Console on page 55.

### Excluding Devices From Pre-Connect

You can use a custom property to exclude devices from the pre-connection configurations. This can be set on a single device or a group of devices. Use the following properties to customize the Remote Control settings:

• **RemoteControl.IgnorePre-connect.** [value (1) = Ignore preconnect] This will prohibit the pre-connect from the mobile device.
To exclude mobile devices from pre-connect configuration:

1. Enable the pre-connect option through the Client Config tab.
2. Ensure your network address on the Server Config tab is correct.
3. Exit the Remote Control Console.
4. In Avalanche Manager or Avalanche MC, create a mobile device group for all devices that you do not want to pre-connect.
5. Add all the devices to the mobile device group.
6. Add the following property to the mobile device group properties:

   `RemoteControl.IgnorePreconnect (value 1)`

**NOTE** For information about creating mobile device groups, refer to the Wavelink Avalanche Manager User’s Guide or the Wavelink Avalanche MC User’s Guide.

---

**Configuring Cellular Carriers**

If you are using an e-mail gateway for SMS messages, you must select your cellular carrier. If your carrier is not in the drop-down list on the Mobile Devices tab, you will need to add your carrier.

**Adding Cellular Carriers**

1. From the Mobile Device tab, click the [...] button.

   The Edit Carriers dialog box appears.

2. In the Carrier text box, enter the name of the new carrier.

3. In the Email text box, enter the e-mail address of the carrier.

   Be sure to include {phone number} in the e-mail address. If you don’t, you’ll receive the following message.
Click OK.

If the carrier you are trying to add already exists, you will receive the following message.

5 If you do not get an error, return to the Mobile Device tab and click Update.

You cellular carrier is added to the list.

**Deleting Cellular Carriers**

When you delete a cellular carrier, any other mobile devices configured to use that carrier are set to (default). This means that the mobile device will not be set to use any carrier until you reconfigure that device. will not Use the following steps to remove a carrier from the list.

**To delete a carrier:**

1 In the Mobile Device tab, click the [...] button.

The Edit Carriers dialog box appears.

2 Use the Previous and Next buttons to find the carrier you want to delete.
3 Once you find the carrier, click **Delete**.

A message box appears.

4 If you are sure you want to delete, click **OK**.

The carrier is removed from the list.
Chapter 7: Configuring Server Settings

Configure the Remote Control Server settings in the Server Settings tab. These settings are deployed to the mobile device when the package is downloaded. From the Server Settings tab, you can perform the following tasks:

- Configuring Connection Server Settings
- Configuring SMS Options

Configuring Connection Server Settings

You can configure the following server settings:

- **Server Address.** This is the address of the Remote Control Server visible to your internal network.
- **Server Port.** Connections between Remote Control and your device use this port. If connections are made via port forwarding, your administrator must assign this port forward to the server. If this port changes, you must restart your connection server.
- **Server ID.** This is a pre-shared key that is used between the Remote Control Server and Remote Control client. When a wide area connection request is made, the key is sent to the client to identify where to connect. Using this pre-shared key, the client can determine the correct IP address with which to connect.
- **WAN Address.** This address is dependent on the type of connection your clients use to connect to the server through a wide area connection.
  - If your clients connect through a VPN connection, this is the internal address of the server which is visible to VPN connections.
  - If your clients connect through port forwarding, this is the externally visible IP address.
- **Command Port.** Remote Control communicates with the Remote Control Server via this port. This port does not have to be forwarded.
• **Corporate Connection.** This determines if VPN or port forwarding will be used by the mobile device connecting to your server.

If this option is enabled, the mobile device establishes a VPN connection using the CE connection manager prior to connecting to the server.

If this option is disabled, the mobile device establishes an internet connection using the CE connection manager prior to connecting to the server.

• **Try Network Connection First.** If this option is enabled, the server attempts to connect to the mobile device before sending a wide area request. The server may be able to establish an 802.11 connection resulting in a faster connection.

• **SMS Setup.** You can configure the SMS setup through an e-mail gateway or through a Local GSM Modem. Once you select your method, click the Configure button to open the specific dialog box for that method. For information on configuring SMS, see Configuring SMS Options on page 65.

**To configure the connection server:**

1. Open the Remote Control Console.

2. Click the Server Settings tab.
Chapter 7: Configuring Server Settings

3 Configure the options in the **Connection Server** region.

4 Click **Update**.

The settings are deployed to the mobile devices upon the next deployment.

**Configuring SMS Options**

You can configure the SMS configuration through the SMS e-mail gateway or through a Local GSM Modem. You can select which method to use in the
**SMS Setup** region of the **Server Settings** tab. Once you select your method, click the **Configure** button to open the specific dialog box for that method.

### SMS Email Gateway Configuration

You can set the following options when configuring your SMS e-mail gateway:

- **Host.** Set the host name of the outgoing mail server.
- **Mail From.** Set the from field of the email.
- **(Pop3) Host.** The pop3 host to use.
- **(Pop3) User ID.** The pop3 user name.
- **(Pop3) Password.** The pop3 password.
- **(Pop3) Pop Before SMTP.** Indicates whether to log into pop3 server before sending mail.
- **(SMTP) User ID.** User name for the SMTP Server.
- **(SMTP) Password.** Password for the SMTP server.
- **(SMTP) Port.** Sets the port number of the outgoing mail server.
- **(SMTP) Use Auth.** Determines if authentication credentials are sent to the outgoing mail server.
- **Debug Mail Session.** Enables the display of debug information in the Remote Control log file.

**To configure the SMS e-mail gateway:**

1. Click the **Server Config** tab.

2. In the **Setup SMS** region, select **SMS Email Gateway** from the **Method** drop-down list.

3. Click **Configure**.

   The **SMS Email Gateway Config** dialog box appears.
Configure the options as desired.

Click **Test Email** to test the e-mail information you entered.

This sends an e-mail to the specified address with the information included in the dialog box.

When you are finished, click **OK** to return to the **Server Config** tab.

**GSM Modem Configuration**

For any typical operation, port settings should not be modified from the default settings. The default port communication settings are:

You can select the manufacture and mode of communications from the drop down menus in the GSM Modem Config dialog box. If your manufacturer
does not appear in the drop-down menus, you can enter a name and mode. This configuration is for GSM modems only and is not supported for GPRS.

- 1152000 bps connection speed (baud)

**To configure GSM modem:**

1. Click the Server Config tab.

2. In the Setup SMS region, select Local GSM Modem from the Method drop-down list.

3. Click Configure.

4. From the Manufacturer combo box, select the device manufacturer (you can also type the name of the manufacturer).

5. From the Mode combo box, select the mode of the GSM modem (you can also type the mode).

6. Click OK to return to the Server Config tab.
Ports List

The following table provides information about the Remote Control ports.

<table>
<thead>
<tr>
<th>Usage</th>
<th>Port</th>
<th>Type</th>
<th>Configurable</th>
<th>Server</th>
<th>RC</th>
<th>Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Connection (see note)</td>
<td>1899</td>
<td>TCP</td>
<td>Yes</td>
<td>In/Out</td>
<td>Out</td>
<td>In/Out</td>
</tr>
<tr>
<td>Server Control</td>
<td>1900</td>
<td>TCP</td>
<td>Yes</td>
<td>In</td>
<td>Out</td>
<td>N/A</td>
</tr>
<tr>
<td>Device Discovery / Status Checks</td>
<td>1903</td>
<td>UDP</td>
<td>No</td>
<td>Out</td>
<td>Out</td>
<td>In</td>
</tr>
</tbody>
</table>

Table 7-1: Remote Control Ports

**NOTE** For wide area reverse connections, this port must be forwarded from the public IP to the internal server address.

Changing Server Information

You can change the server address and port information.

**To change server information:**

1. From the File menu, select Change Server.

   A Wavelink Remote Control dialog box appears.
2 Change the Server Address and Port.

3 Click OK to save your changes.

The server information updates.
Chapter 8: Connecting to Mobile Devices

After you configure connection profiles, client settings and server settings in the Remote Control Console, you can deploy the client portion of Remote Control to the mobile device. Once the mobile device receives the client, you can create Remote Control connection sessions. A connection session is when the mobile device is connected to Remote Control allowing you to view and control the mobile device.

This section provides information about the following Remote Control connection tasks:

• Deploying Remote Control Client to the Mobile Device
• Connecting to a Mobile Device
• Closing Remote Control Sessions
• Sending SMS Messages to Mobile Devices

**NOTE** If you have not licensed Remote Control, you will not be able to connect to the mobile device.

Deploying Remote Control Client to the Mobile Device

This section provides information on the following Remote Control client deployment methods:

• Deploying From Avalanche Manager
• Deploying From Avalanche MC

**NOTE** Close the Remote Control Console before you perform any deployments or save any changes in the Avalanche Manager or Avalanche MC Console. If you deploy with the console open, your package sync may fail and you will be unable to open the Remote Control Console again.
Deploying From Avalanche Manager

You can deploy the client portion of Remote Control to mobile devices that are currently in range and running the Avalanche Enabler. Mobile devices automatically pull updates from the Avalanche Manager Agent whenever the Enabler activates. You can also push global updates or individual updates to mobile devices from the Avalanche Manager Agent.

NOTE For detailed information about performing updates, refer to the Wavelink Avalanche Manager User’s Guide.

Deploying From Avalanche MC

You can deploy the client portion of Remote Control to mobile devices that are currently in range and running the Avalanche Enabler. You can perform global updates (Universal Updates) or individual updates. Universal Updates, configured in the Task Scheduler, allow you to select the dServer Locations and regions to which you want to deploy Remote Control. Individual updates, configured in the Device Control tab, deploy software packages and configuration changes to a single mobile device.

NOTE For specific instructions about deploying software packages from Avalanche MC, refer to the Wavelink Avalanche Mobility Center User’s Guide.

Connecting to a Mobile Device

You can open a Remote Control Viewer session over an ActiveSync or TCP/IP connection. If you are creating a session using ActiveSync, ensure you have created an ActiveSync session. If you are creating a session using a TCP/IP connection, ensure you know the IP address of the mobile device.

If Remote Control located your mobile device automatically, the device will appear in the Mobile Device tab.

To connect to a device:

1. From the Mobile Device tab, select the mobile device to which you want to connect.
2 In the Profile list box, select the profile you want to use to connect to this device.

3 From the Mobile Device tab, right-click on the device name and click Connect.
   -Or-
   From the Mobile Device tab, select the mobile device name and click Connect.
   
   If the device requires a password, the Password Required dialog box appears.

4 Enter the Password and click OK.
   
   The Remote Control Viewer appears.
   
   Clicking within the Remote Control Viewer sends the mouse click to the connected device. Typing on the physical keyboard sends the key commands to the mobile device.

## Closing Remote Control Sessions

There are two methods to close a Remote Control session. You can close the Remote Control Viewer or you can force a remote disconnect.

**To close the connection window:**

- From the Remote Control Viewer, select File > Exit.
  
  -Or-
  
  - Close the Remote Control Viewer.

**To force disconnect:**

1 From the Remote Control Console, select the Mobile Devices tab.

2 From the Mobile Device list, select the mobile device you want to close.

3 Click Status.

   The Device Status dialog box appears. This dialog box provides device and connection information.
If the mobile device is still connected to a Remote Control session, the **Device Status** line displays as **Connected**.

4 Click **Disconnect**.

The mobile device is disconnected from the Remote Control session.

**Sending SMS Messages to Mobile Devices**

When Remote Control is configured for SMS, you can send SMS messages to your mobile devices. This allows you to send notifications to the users, to wake a device in order to begin a Remote Control session, or direct a mobile device to connect to the Avalanche server and update. This section provides information for the following tasks:

- Sending an SMS Message
- Waking a Suspended Device Using SMS
- Using Avalanche Update Now (SMS)

**NOTE** SMS messages are only available if Remote Control has the SMS Setup configured. For more information on configuring the SMS Setup, see *Configuring SMS Options* on page 65.
Chapter 8: Connecting to Mobile Devices

Sending an SMS Message

When Remote Control is configured for SMS, you can send SMS messages to your mobile devices from either the Remote Control Console or the Avalanche Console.

To send an SMS message from the Remote Control Console:

1. From the Remote Control Console, click the Mobile Devices tab.

2. Right-click the device you want to send a message to, and click Send Message (SMS).

   The Send Message dialog box appears.

3. Enter the text of your message in the Message text box. When you are finished, click OK.

   The message will be delivered to the mobile device.

To send an SMS message from the Avalanche Console

1. On the Avalanche Console, navigate to the Mobile Device Inventory tab.

2. Right-click the device you want to send a message to, and click Remote Control SMS > SMS Text Message.

   The Send Message dialog box appears.

3. Enter the text of your message in the Message text box. When you are finished, click OK.

   The message will be delivered to the mobile device.

Waking a Suspended Device Using SMS

If a device is suspended and not in contact with the Remote Control server, you can contact the device using SMS and request that it contact the Remote Control server in order to create a Remote Control session.

To request a device contact the server:

1. Launch the Remote Control Console and select the Mobile Device tab.

2. From the Mobile Device list, select the mobile device to which you want to connect.
3 In the **Profile** list box, select a profile that uses server as the connection type.

4 Ensure the phone number for the device is configured. If you are using an e-mail gateway, you must also have the carrier selected. If you make changes to these options, click **Update** to save the changes.

5 Click **Connect** to send the message.

   If the device requires a password, the **Password Required** dialog box appears. Enter the **Password** and click **OK**.

Remote Control sends the message to the mobile device, waking it up and requesting it contact the Remote Control server. Once the mobile device contacts the server, you can begin a Remote Control session.

**Using Avalanche Update Now (SMS)**

When Remote Control is configured for SMS, you can send SMS Update Now messages to your mobile devices from either the Remote Control Console or the Avalanche Console. The Update Now message directs the device to connect to the Avalanche server and update.

**To send an SMS Update Now message from the Remote Control Console:**

1 From the Remote Control Console, click the **Mobile Devices** tab.

2 Right-click the device you want to send a message to, and click **Avalanche Update Now (SMS)**.

   The message will be delivered to the mobile device, and the device will connect to the Avalanche server and update.

**To send an SMS Update Now message from the Avalanche Console:**

1 On the Avalanche Console, navigate to the **Mobile Device Inventory** tab.

2 Right-click the device you want to send a message to, and click **Remote Control SMS > SMS Update Now**.

   The message will be delivered to the mobile device, and the device will connect to the Avalanche server and update.
Chapter 9: Remote Control Viewer Tasks

This chapter provides information about using Remote Control once you are connected to a mobile device. The tasks detailed in this chapter assume you are connected to a mobile device. For information about creating a connection session, refer to Chapter 8: Connecting to Mobile Devices on page 71.

Once you connect to a mobile device, Remote Control offers a variety of functionality, tools and configuration options. The Remote Control Viewer consists of the following tabs:

- **Device.** From this tab you can view the mobile device and perform operations on the mobile device using key strokes and mouse actions. You can also perform Remote Control operations such as toggle the skin, perform screen captures, and record scripts and AVI files.

- **File System.** From this tab you can access the file system on the mobile device. For detailed information about tasks you can perform in the File System tab, refer to Using the File System on page 78.

- **Registry Viewer.** The Registry Viewer allows you to view and edit the registry on the mobile device. For detailed information about the Registry Viewer, refer to Using Registry Viewer on page 83.

- **Processes.** The Process Manager provides a view of the processes that are currently running on the mobile device. For detailed information, refer to Using the Process Manager on page 92.

- **Access Log.** The Remote Control logging feature stores information about the current connection session of Remote Control. For detailed information, refer to Accessing the Log File on page 93.

- **Device Info.** The Device Info tab provides information about the mobile device to which you are connected. For detailed information, refer to Viewing Device Information on page 97.

- **Scripts.** The Scripts tab allows you to run configured script scenarios. For more information about scripts and scenarios, refer to Chapter 9: Configuring Scripts and Scenarios on page 101.

This chapter also provides information about the following tasks:

- Performing Screen Captures
• Enabling Device Skins
• Pasting Text Information
• Recording AVI Files
• Configuring Video Mode

**Viewing the Mobile Device**

When you create a Remote Control connection session, the *Remote Control Viewer* displays the **Device** tab by default. This tab allows you to see the mobile device screen. Clicking within the *Remote Control Viewer* sends the mouse click to the connected device. Typing on the physical keyboard sends the key commands to the mobile device.

**Using the File System**

You can access the File Explorer of the mobile device from your PC server. This enables you to perform tasks and operations in the File Explorer on the mobile device from your Remote Control connection session.

This section provides information about the following tasks:

• Opening the File Explorer
• Creating New Folders
• Copying Files to the PC
• Copying Files from PC to Mobile Device
• Opening Files
• Viewing Files
• Deleting Files

**Opening the File Explorer**

You can use the File Explorer to create new folders, rename folders, delete folders and move files from the mobile device to the PC.
To open the File Explorer:

- Click the File System tab.

The File Explorer opens.

![File System Explorer](image)

**Figure 9-1. File System Explorer**

**NOTE** If you are using Avalanche MC, you can also access the File System Mobile Device Details dialog box. Click the Device Control tab and then double-click the File System icon.
Creating New Folders

You can create and name folders in the File Explorer.

To create a new folder:
1  Open the File Explorer.
2  Navigate to the location where you want to create the new folder.
3  Right-click and select New.
   The folder is created in the selected location.
4  Right-click the new folder and select Rename Folder.
5  Type the name of the folder.

Copying Files to the PC

You can copy files from the mobile device and place them on the PC.

To copy files to the PC:
1  Open the File Explorer.
2  Select the file you want to copy to the PC.
3  From the Files menu, select Copy to PC.
   -Or-
   Right-click the file you want to copy and select Copy to PC.
   The Browse for Folder dialog box opens.
4  Navigate to the location where you want to save the file.
5  Click OK.
   The folder is copied to the selected location.

NOTE You can also drag files directly from the PC and drop them into the File Explorer.
Copying Files from PC to Mobile Device

You can copy files from the machine running Remote Control and place them in the File Explorer of a connected mobile device.

To copy files to the PC:
1. Open the File Explorer.
2. Navigate to where you want to place the files.
3. From the Files menu, select Copy from Remote.

   The Open dialog box appears.
4. Locate the file that you want to copy to the mobile device and click OK.

   The Sending Files Status dialog box appears.

   ![Sending Files Status](image)

   **Figure 9-2. Sending Files**

   The files are copied to the selected location.
5. Once the file transfer is complete, click OK.
Running Programs

From the File Explorer, you can run programs located on the mobile device. You can run any file with an .exe extension. To open other types of files, refer to Opening Files on page 82.

To run a program:
1. Open the File Explorer.
2. Using the Tree View, navigate to the location of the program you want to run.
3. Right-click the file and select Run.
   The program opens on the mobile device.
4. Click the Device tab to view the mobile device screen and the program.

Opening Files

Access files on the mobile device from the File Explorer. This opens the file on the mobile device. For .exe files, refer to Running Programs on page 82.

To open a file:
1. Open the File Explorer.
2. Using the Tree View, navigate to the location of the file you want to open.
3. Right-click the file and select Open.
   The file opens and display on the mobile device.
4. Click the Device tab to view the mobile device screen and the file.

Viewing Files

You can view files located on the mobile device on the PC running Remote Control.

1. Open the File Explorer.
2. Using the Tree View, navigate to the location of the file you want to view.
3. Right-click the file and select View.
Chapter 9: Remote Control Viewer Tasks

The file opens and display on PC.

**Deleting Files**

You can delete files on the mobile device from the File Explorer.

**To delete files:**

1. Open the File Explorer.
2. Navigate to the location of the file you want to delete.
3. Right-click the file and select **Delete**.

   The file is removed from the mobile device.

**Using Registry Viewer**

From the Registry Viewer, you can browse and view the Registry of a connected mobile device. This section provides information about the following Registry Viewer tasks:

- Viewing the Registry
- Creating New Registry Keys
- Creating Key Values
- Viewing Binary Data
- Modifying Key Values
- Modifying Binary Data
- Deleting Key Values
- Exporting Registries
- Comparing Registries

**Viewing the Registry**

You can view the registry from the **Remote Control Viewer**.
To view the registry of the device:

1. Click the Registry Viewer tab.

   The Registry Viewer appears.

   ![Figure 9-3. Viewing the Registry Viewer](image)

2. Click the list items to expand the registry.

   **NOTE** If you are using Avalanche MC, you can also access the File System through the Mobile Device Details dialog box. Click the Device Control tab and then double-click the Registry Viewer icon.
Creating New Registry Keys

From the Registry Viewer tab, you can create new registry keys on the mobile device.

To create a new registry key:
1. Open the Registry Viewer.
2. Navigate to where you want to create a new key.
3. Right-click and select New Key.
   A New Key folder appears.
4. Right-click the New Key folder and select Rename.
5. Name the folder.

Creating Key Values

You can create String, Binary, DWORD, and Multi-String values in the mobile device registry.

To create key values:
1. Open the Registry Viewer.
2. Navigate to where you want to create a new key.
3. Right-click and from the menu that appears, select the key value you want to create.
   The value appears in the file list box.

Viewing Binary Data

For any registry key, you can display the binary data for that key.

To view binary data:
1. Open the Registry Viewer.
2. Navigate to the location of the key you want to view.
3. Right-click the key and select Display Binary Data.
The Binary Data dialog box appears.

![Figure 9-4. Binary Data](image)

4 Use the options in the Format region to display the data in **Byte**, **Word** or **Dword** format.

5 Click OK when you are finished.

**Modifying Key Values**

You can modify key values in the Registry Viewer.

To modify key values:

1 Open the Registry Viewer.

2 Navigate to the location of the key you want to edit.

3 Right-click the key and select **Modify**.

A dialog box appears according to what type of key you are modifying.

- If you are modifying a String or Binary value, the **Edit String** dialog box appears.
• If you are modifying a DWORD key value, the *Edit DWORD Value* dialog box appears.

• If you are modifying a Multi-String value, the *Edit Multi-String* dialog box appears.
Using the configuration options available in each dialog box, edit the key value.

Click OK when you are finished.

The key value is modified.

**Modifying Binary Data**

You have the ability to modify the binary data of each type of key value in the Registry Viewer.

**To modify binary data:**

1. Open the Registry Viewer.

2. Navigate to the location of the key you want to modify.

3. Right-click the key and select **Modify Binary Data**.

The *Edit Binary Value* dialog box appears.
In the Value data text box, edit the binary value as desired.

5 Click OK when you are finished.

**Deleting Key Values**

You can delete key values that you no longer need.

**To delete key values:**

1 Open the Registry Viewer.

2 Navigate to the location of the key you want to delete.

3 Right-click the key and select **Delete**.

A dialog box appears asking you to confirm that you want to delete this key value.

4 Click **Yes** if you want to permanently delete the value.

The key value is removed from the registry.
**Exporting Registries**

You can export registries from the mobile device and save them as `.xml` files on your computer.

**To export a registry:**

1. Open the Registry Viewer.
2. Navigate to the location of the registry you want to export.
3. From the File menu, select **Export**.
   
   A standard **Save As** dialog box appears.
4. Navigate to the location where you want to save the registry.
5. Name the registry and click **Save**.

   The registry is saved as an `.xml` file.

**Comparing Registries**

There are two methods you can use to compare registries:

- Compare Registry to Exported Registry
- Compare Registry with Another Device Registry

**Compare Registry to Exported Registry**

You can compare the registry on a mobile device to a registry you have saved and exported.

**To compare to an exported registry:**

1. Open the Registry Viewer.
2. From the File menu, select **Compare**.
   
   A dialog box appears.
3 Select the **Existing Registry** option and click **OK**.

A standard *Open* dialog box appears.

4 Navigate to the location of the registry to which you want to compare and click **Open**.

A *Registry Compare* dialog box appears in a separate window displaying the existing registry file.

5 Move the windows until you can view both registries.

6 When you are finished comparing registries, close the *Registry Compare* dialog box.

---

**NOTE** You can not edit any registry folders or values in the *Registry Compare* dialog box.

---

**Compare Registry with Another Device Registry**

When you want to compare your device registry to another device registry, you can connect to the device and open both registries.

**To compare to another device registry:**

1 Open the Registry Viewer.

2 From the *File* menu, select **Compare**.

A dialog box appears.
3 Select the **Another Device** option and click **OK**.

The *Choose Connection* dialog box appears.

4 Select what type of connection you want to create to the new device.

5 If you select a **Network** connection, enter the **IP address** of the mobile device.

   A *Registry Compare* dialog box appears in a separate window displaying the mobile device registry file.

6 Move the windows until you can view both registries.

7 When you are finished comparing registries, close the *Registry Compare* dialog box.

### Using the Process Manager

The **Processes** tab in the *Remote Control Viewer* allows you to view the processes that are currently running on the mobile device. You have the option to activate or kill (end) any of the processes. Activating a process brings that process to the front of any other programs running on the mobile device. Killing a process stops the process.

**To use the Process Manager:**

1 Click the **Processes** tab.
Figure 9-11. Process Manager

2 Select a process and right-click to **Activate** or **Kill** that process.

### Accessing the Log File

The Remote Control logging feature stores information about the current connection session of Remote Control.

This section provides information about the following logging options:

- Configuring Logging
- Viewing the Log File
• Clearing Log Files
• Saving Log Files

**Viewing the Log File**

You can view the log file for a current Remote Control session from the Access Log tab.

**To view the log file:**
• In the Remote Control Viewer, click the Access Log tab.

**Configuring Logging**

Remote Control supports the following log levels:

• **Critical.** This level writes the least information to the log file, reporting only critical errors that have caused the Avalanche Agent service to crash.

• **Error.** This level writes Error messages and Critical messages to the log file.

• **Warning.** This level writes Critical messages, Error messages, and Warning messages to the log file.

• **Info.** This level is the default logging level and the Wavelink-recommended setting. This logging level writes enough information to the log file to diagnose most problems.

• **Debug.** This logging level writes large amounts of information to the log file that can be used to diagnose more serious problems.

You can change the logging for a particular connection session through the Configure dialog box located in the Remote Control Viewer. You can also set up the logging configuration when you create a connection profile. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.

**To change the logging configuration:**
1. Click the Access Log tab.
2. From the File menu, select Configure.
The *Configure* dialog box appears.

![Figure 9-12. Configuring Logging](image)

3 In the **Logging** region, select the log level from the **Level** drop-down menu.

4 Enter the maximum size you want the log level to reach in the **Max Size** text box.

5 Click **OK**.

The *Configuration Data Change* dialog box appears. This dialog box indicates that you changed something from original profile configuration.
6 If you want to use your updated changes, but do not want to update the configuration file, select the Use New Configuration option.

7 If you want to use your updated changes and update the configuration file to reflect those changes, select the Use New Configuration and Update config file option.

8 Click OK.

The new logging information is applied.

**Clearing Log Files**

If you need to delete the information that displays in the log file, you can clear the entire file. When you select to clear the log file, the entire log in the Access Log tab is removed. You can not select individual items to clear.

**To clear the log file:**

1 Click the Access Log tab.

2 From the Edit menu, select Clear.

   - Or -

   Right-click within the log and select Clear.

   The Access Log tab clears.

**Saving Log Files**

The log file does not have a maximum capacity and continues to log information until the Remote Control Console restarts. Once the console is
started, the previous log file is reset and information about the new connection is stored. However, you can save log files under a different name if you wish to retain log files.

Remote Control log files are stored in the DeviceLogs folder in the Remote Control installation directory.

**To save the log file:**

1. Access the Wavelink RemoteControl.log.
2. Open the log file in a plain text editor.
3. Rename the log file as something other than RemoteControl.log.

**Note:** If you do not rename the log file and save it, once you restart the Remote Control Console, the previous log is discarded and the RemoteControl.log file will log data from the new connection sessions.

### Viewing Device Information

The **Device Info** tab in the Remote Control Viewer provides information about the mobile device to which you are connected. This information includes:

- Identification, including OEM information and the operating system versions.
- Memory, including the amount of free memory left on the device and storage space.
- Power, including information about the battery level and charging status of the mobile device.
- Screen, including information about the screen size and orientation.
- Security, including password information.

**To view device information:**

- From the Remote Control Viewer, click the **Device Info** tab.
Recording AVI Files

Wavelink Remote Control allows you to record AVI files. The AVI file is saved in the \texttt{RECORDED\_DATA} folder under the Remote Control install directory. You can play the AVI file on any program compatible with the AVI video file format, such as Windows Media Player.

This section provides information about the following tasks:

- Selecting Recording Methods
- Recording AVI Files
Selecting Recording Methods

Before you can record an AVI file, you must enable AVI as the recording method. You can select the AVI recording method from the Configure dialog box in the Remote Control Viewer. You can change the recording method configuration for a particular connection session through the Configure dialog box.

You can also configure the recording method when you create a connection profile. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.

To select the recording method:
1. From the File menu, select Configure.

The Configure dialog box appears.

![Figure 9-15. Configuring the Recording Method](image-url)
2 In the **Recording Method** region, select the **AVI video** option as the recording method.

3 If you want the cursor to display in the AVI video, enable the **Show Cursor** option.

4 Click **OK**.

The **Configuration Data Change** dialog box appears. This dialog box indicates that you changed something from original profile configuration.

![Configuration Data Changed](image)

*Figure 9-16. Configuration Data Changed*

5 If you want to use your updated changes, but do not want to update the configuration file, select the **Use New Configuration** option.

6 If you want to use your updated changes and update the configuration file to reflect those changes, select the **Use New Configuration and Update config file** option.

7 Click **OK**.

The new recording method information is applied.

**Recording AVI Files**

You can record actions and tasks and then save your actions as AVI file from the **Remote Control Viewer**. You can use the recordings for demonstration purposes or training.

To record the AVI file:

1 In the **Remote Control Viewer**, click the Record tool bar icon.

   The **Save As** dialog box appears.
2 Name the file and click Save.

The Video Compression dialog box opens.

![Video Compression dialog box](image)

**Figure 9-17. Configuring Video Compression**

3 Configure the compression options and click OK.

4 From the Device tab in the Remote Control Viewer, perform the actions on the mobile device that you want to record.

5 Click the Stop Record tool bar icon when you are finished.

   The AVI file is saved in the \RECORDED_DATA folder in the Remote Control installation directory.

**Performing Screen Captures**

When you are connected to a mobile device through a Remote Control session, you can capture screen images from the mobile device. This section provides information about the following tasks:

- Selecting Screen Capture Methods
- Performing Screen Captures

**Selecting Screen Capture Methods**

Before you can take screen captures using Remote Control, you must select the method by which you want to capture the screen image. You can capture screen shots using three different methods:
• **File.** Use this option to save the image to a specified file. Once you capture the screen image, you can specify where you want to save the file.

• **Clipboard.** Use this option to place the image on the clipboard.

• **One-click.** Use this option to click once and send the screen capture to a previously specified file format. The file format must be chosen in the Configure dialog box. The file name will be automatically created based on the current time and date. The file will be placed in the default C:\_AVA\localhost\MAIN\[Device Name]\WLRMTCTL\APPS\WLRMTCTL\RECORDED_DATA folder.

You can configure screen capture methods from the Remote Control Viewer. You can also configure screen capture methods when you create Remote Control connection profiles. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.

**To configure the screen capture method:**

1. In the Remote Control Viewer, select **File > Configure.**

   The Configure dialog box opens.
2 In the Screen Capture region, select the method you want to use when performing screen captures.

3 Click OK.

The Configuration Data Change dialog box appears. This dialog box indicates that you changed something from original profile configuration.
4 If you want to use your updated changes, but do not want to update the configuration file, select the **Use New Configuration** option.

5 If you want to use your updated changes and would like to update the configuration file to reflect those changes, select the **Use New Configuration and Update config file** option.

6 Click OK.

The screen capture method you configured is now enabled.

**Performing Screen Captures**

Once you configure the screen capture method, you can use the camera tool bar icon to capture screen images.

**To perform a screen capture:**

1 In the **Device** tab, navigate to the screen view of the mobile device you want to capture.

2 Click the Camera tool bar icon.

The image is saved according to the screen capture method you configured in the **Configure** dialog box.

**Enabling Device Skins**

From the **Remote Control Viewer**, you can toggle between a selected skin and the default view (no skin). To use skins, you must enable the **Show Skin** option when you are creating connection profiles or from the **Configure** dialog box in the **Remote Control Viewer**.

This section provides information about the following tasks:

- Enabling the Show Skin Option
- Toggling the Skin

**Enabling the Show Skin Option**

If you did not enable the **Show Skin** option when you created your connection profile, you can configure the connection to display skins from the **Remote Control Viewer**.
NOTE You can also configure how you want your mobile device skins to display when you create connection profiles. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.

To enable Show Skin:

1. From the File, select Configure.
   
   The Configure dialog box appears.

   ![Figure 9-20. Enabling the Show Skin Option](image)

2. Enable the Show Skin option.

3. Select which skin to display from the Skin drop-down list.

4. Click OK.

   The Configuration Data Change dialog box appears. This dialog box indicates that you changed something from original profile configuration.
5 If you want to use your updated changes, but do not want to update the configuration file, select the **Use New Configuration** option.

6 If you want to use your updated changes and would like to update the configuration file to reflect those changes, select the **Use New Configuration and Update config file** option.

7 Click **OK**.

The skin image appears in the **Device** tab of the **Remote Control Viewer**.

**Toggling the Skin**

Once the **Show Skin** option is enabled, you can toggle between the selected skin and the default view of Remote Control

**To toggle the skin:**

- Click the **Toggle Skin** tool bar icon.

- Or-

  Select **View > Toggle Skin**.

**Refreshing the Display**

You can configure the rate at which Remote Control refreshes the mobile device screen display.

This section provides the following information:

- Configuring Refresh Rates
• Refreshing the Mobile Device Display

Configuring Refresh Rates

The refresh rate can range from one to 18 frames per second. Your selection is dependent on the speed of the mobile device and the communication method you are using. Select the best setting for your usage that does not impact the mobile device CPU too heavily and allows for reasonable screen updates.

NOTE You can also configure the refresh rate option when you create connection profiles. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.

To configure the refresh rate:

1 From the File menu, select Configure.

The Configure dialog box appears.

Figure 9-22. Enabling the Show Skin Option
2 From the Refresh Rate drop-down list, select the rate at which you want the screen display to refresh.

3 Click OK.

The Configuration Data Change dialog box appears. This dialog box indicates that you changed something from original profile configuration.

4 If you want to use your updated changes, but do not want to update the configuration file, select the Use New Configuration option.

5 If you want to use your updated changes and would like to update the configuration file to reflect those changes, select the Use New Configuration and Update config file option.

6 Click OK.

The device will display as a 16-color image in the Device tab.

**Refreshing the Mobile Device Display**

Once you have configured the refresh rate, you can use the refresh button to update the mobile device screen display.

**To refresh the display:**

- Click the Refresh toolbar icon.
- From the View menu, select Refresh Display.
Sizing Mobile Device Display

You can configure the size of the mobile device display to scale from .5x - 4x. There is also an autoscale option that will fit the display to the size of the window you have open. Once you connect to the mobile device, you can change the scale setting and magnify or shrink the display.

This section provides the following information:

- Configuring Scale Settings
- Changing the Display Size

Configuring Scale Settings

If you did not configure the scale setting when you created your connection profile, you can configure it from the Remote Control Viewer.

NOTE You can also configure scale setting when you create connection profiles. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.

To set the scale of the display:

1. From the File menu, select Configure.

   The Configure dialog box appears.
2 From the Scale drop-down list, select the size of the mobile device display.

3 Click OK.

The Configuration Data Change dialog box appears. This dialog box indicates that you changed something from original profile configuration.
4 If you want to use your updated changes, but do not want to update the configuration file, select the **Use New Configuration** option.

5 If you want to use your updated changes and update the configuration file to reflect those changes, select the **Use New Configuration and Update config file** option.

6 Click **OK**.

The device will appear as the size you selected.

**Changing the Display Size**

You can change the size of the mobile device display while you are connected to a mobile device.

**To change the scale size:**

- From the **View Menu**, select **Scale** and then the size you want the display to be.

- Or-

- Use the **Zoom In, Zoom Out or Autoscale** toolbar options to adjust the size of the display.

**Pasting Text Information**

Remote Control allows you to copy and paste information from the PC to the mobile device. Only textual information can be copied and pasted. For example, you could copy text from a text editor on the PC to Pocket Word on the mobile device. Both text editors must be open.

Use the **Paste to device** command to paste information from the PC to the mobile device.

**To copy and paste information:**

1 Open a plain text editor on both PC and the mobile device.

2 From the text editor on your PC, select the text to be copied and pasted.

3 Right-click and select **Copy**.

4 In the **Remote Control Viewer** select **Edit > Paste to device**.
The information appears in the text editor on the mobile device.

**Setting Video Mode**

You can set two types of video mode depending on how you want the mobile device screen to appear and how fast you want the program to run.

- **Standard Mode.** This mode provides the clearest, most accurate screen images. However, the refresh rate is slower over wide area connections.

- **Image Mode.** This mode provides faster screen updates with reduced image quality. You can set the screen display quality from 1-99 based on preference.

**To set video mode:**

1. Click the Video Mode icon.

   The *Set Video Mode* dialog box appears.

   ![Set Video Mode dialog box](image)

   **Figure 9-26.** *Set Video Mode*

2. Select the video mode you want to use and click **OK**.
Resetting Mobile Devices

You can force a warm-boot on the mobile device using the Soft Reset option. When you reset the mobile device, the Remote Control connection is lost. You will need to reestablish a Remote Control connection after the reset.

**To reset the mobile device:**
1. Click the Device tab.
2. From the Tools menu, select Soft Reset.

   The mobile device performs a warm-boot and the Remote Control connection is lost.

Suspending Mobile Devices

You can place a mobile device in a suspended, or sleep, state while you are connected through Remote Control. When you suspend the mobile device, the Remote Control connection is lost. You will need to wake up the mobile device before you can reconnect using Remote Control.

**To suspend the mobile device:**
1. Click the Device tab.
2. From the Tools menu, select Suspend.

   The mobile device is suspended and the Remote Control connection is lost.

Toggling Statistics

You can display device statistics at the bottom of the Remote Control Viewer. The following statistics display:

- Bytes Sent
- Bytes Received
- Keys (Number of keys pressed)
- Clicks (Number of mouse clicks)
To toggle statistics:

1. Click the Device tab.

2. From the View menu, select Toggle Statistics.
Chapter 10: Configuring Scripts and Scenarios

In Remote Control, a script is defined as a recording of a particular action. A scenario is a compilation of scripts. Using Remote Control, you can create scenarios to control your mobile device. You begin by generating text scripts from mouse and keyboard events. You can then arrange and compile these scripts to create scenarios based on what you want the device to do and the order in which to perform the tasks.

Scenarios allow you to run several scripts in a predefined sequence. Using scenarios you can create predefined commands that activate upon connection to a mobile device.

This section provides information about the following tasks:

- Generating Scripts
- Creating Script Scenarios
- Executing Scenarios

Generating Scripts

You can generate scripts from the Remote Control Viewer. Generating scripts consists of the following tasks:

- Configuring the Recording Method
- Recording Scripts
- Editing Scripts

Configuring the Recording Method

If your profile is not configured to record script events, you can change the configuration from the Remote Control Viewer.

NOTE You can also configure create a connection profile that is configured to record script events. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.
To configure the recording method:

1. Create a Remote Control connection session.

2. From the File menu, select Configure.

   The Configure dialog box opens.

   ![Configure dialog box]

   Figure 10-1. Configuring the Recording Method

3. In the Recording Method region, select Script events.

4. Click OK.

   The Configuration Data Change dialog box appears. This dialog box indicates that you changed something from original profile configuration.
5 If you want to use your updated changes, but do not want to update the configuration file, select the **Use New Configuration** option.

6 If you want to use your updated changes and would like to update the configuration file to reflect those changes, select the **Use New Configuration and Update config file** option.

7 Click OK.

You can now record script events.

**Recording Scripts**

Once you have configured the profile to record script events, you can record scripts. When you record a script, the script is saved as a plain text file in the Remote Control installation directory location.

**To record a script:**

1 Ensure you are connected to a mobile device.

2 Click the Record toolbar icon.

   - **or**-

   From the **Tools** menu, select **Start Recording**.

3 Use the keyboard and mouse to perform the tasks that you want the script to contain.

4 Click the Stop Record toolbar icon.

   - **or**-
From the **Tools** menu, select **Stop Recording**.

The *Save Script* dialog box appears.

![Save Script dialog box](image)

**Figure 10-3. Saving the Script File**

5. Enter a name for script and click **OK**.

The script is saved in the *Scenarios.xml* file in the Remote Control installation directory location.

**Editing Scripts**

You can manually edit a previously recorded script in a plain text editor or an xml editor.

Use the following keywords and parameters when you are editing a script:

- **MOUSEDOWN**, *x*, *y*  
  Simulate a left mouse button press and its location.

- **MOUSEUP**, *x*, *y*  
  Simulate a left mouse button release and its location.

- **DOUBLECLICK**, *x*, *y*  
  Simulate a left mouse button double-click and its position.

- **RMOUSEDOWN**, *x*, *y*  
  Simulate a right mouse button press and it's location.
Each command should be on a separate line. Commas between the keywords and the parameters are required. Comment lines begin with a semicolon.

To edit a script:
1. Navigate to the location of the saved script and open the script in a plain text editor.
2. Enter the desired commands.
3. Save the edited text file.

Examples
The following script is a sample script that displays and then dismisses the About dialog and then attempt to launch PQView when it is run in the Remote Control Viewer.

```
MOUSEDOWN, 110, 181
SLEEP, 371
MOUSEUP, 110, 181
SLEEP, 811
MOUSEDOWN, 115, 228
SLEEP, 330
MOUSEUP, 115, 228
SLEEP, 2000
LAUNCH, \Windows\Start Menu\PQView.exe
```

```r
RMOUSEUP, x, y
RDOUBLECLICK, x, y
MOUSEMOVE, x, y
KEYDOWN, code
KEYUP, code
LAUNCH, appname
SLEEP, time
```

Simulate a right mouse button release and its location.
Simulate a right mouse button double-click and its location.
Simulate a mouse move and its location.
Simulate a key press with virtual-key code.
Simulate a key release.
Launch an application on the remote device.
Insert a delay of n milliseconds.
Creating Script Scenarios

You can create script scenarios by arranging one or more scripts in either the Scripts tab in the Remote Control Viewer or in the Scenarios tab in the Remote Control Console.

Creating Scenarios from the Connection Window

This section provides information following tasks used to create scenarios:

- Adding a New Scenario
- Configuring Scenarios
- Adding Scripts
- Removing Scripts
- Deleting Scenarios

Any scripts that you create in the Remote Control Viewer will be added to the Scenarios tab in the Remote Control Console.

Adding a New Scenario

When you add a new scenario, it appears in the Scenario list box.

To add a new scenario:

1. Click the Scripts tab.
Chapter 10: Configuring Scripts and Scenarios

2 From the Scenarios menu, select **Add**.

A new Scenario appears in the Scenarios list box.

**Configuring Scenarios**

Configuring the scenario allows you to set how many times you want the scenario to run, the time delay between each scenario loop and what the device should do at the end of the scenario.
To configure a scenario:

1 In the Scripts tab, right-click the scenario and select Edit.

The Edit Scenario dialog box appears.

![Edit Scenario dialog box]

**Figure 10-5. Editing Scenarios**

2 Enter the Scenario Name.

3 In the Loop Count text box, enter the number of times you want this scenario to run.

4 In the Loop Delay text box, enter the time delay you want between each loop of the scenario.

5 If you want to suspend the device when the scenario completes, enable the Suspend Device When Complete option.

6 If you want to reboot the mobile device when the scenario completes, enable the Reset Device When Complete option.

7 If you want to disable video updates, enable the Disable Video Update option.

8 Click OK when you are finished.
Adding Scripts
You must add at least one script to a scenario to run the scenario.

NOTE Scripts can not be run on their own. They must be part of a scenario. For information about creating scripts, refer to Generating Scripts on page 115.

To add scripts:
1 Select a scenario from the scenario list box.
2 In the script list box, right-click and select Add.

   The Edit Script Entry dialog box appears.

   ![Edit Script Entry](image)

   Figure 10-6. Edit Script Entry

3 From the Script File drop-down list, select which script you want to add to this scenario.
4 In the Loop Count text box, enter the number of times you want this script to run.
5 In the Loop Delay text box, enter the time delay you want between each loop of the script.
6 Click OK when you are finished.

   The script is added to the scenario.
7 Continue adding scripts until your scenario is complete.
When you are finished, you can run your scenario. For more information about running scenarios, refer to *Executing Scenarios* on page 129.

**Removing Scripts**

If you have a script that you do not want to be part of a scenario, you can remove that script, but keep the rest of the scenario intact.

**To remove a script:**

1. In the Remote Control Console, select the **Scenarios** tab.
2. Select the Scenario that contains the script you want to remove.
3. In the script list box, select the script you want to remove from the scenario.
4. From the **Scripts** menu, select **Delete**.

   The script will be removed from the scenario. The script will remain available for other scenarios unless you remove it from the *Manage Saved Events* dialog box. For more information, refer to *Managing Scripts* on page 128.

**Deleting Scenarios**

When you no longer need a scenario, you can remove that scenario from the list box.

**To delete a scenario:**

1. In the Remote Control Console, select the **Scenarios** tab.
2. Select the scenario you want to remove.
3. From the **Scenarios** menu, select **Delete**.

   The scenario is deleted.

**Creating Scenarios from the Console**

When you create scenarios in the Remote Control Console, you perform the same tasks as you would if you created the scenarios in the Remote Control Viewer, including:

- Adding New Scenarios
• Configuring Scenarios

• Adding Scripts

This section also provides information about the following tasks:

• Removing Scripts

• Deleting Scenarios

Any scripts that you create in the Remote Control Console will be available in the **Scripts** tab of the Remote Control Viewer.

**Adding New Scenarios**

When you add a new scenario, it appears in the scenario list box.

**To add a new scenario:**

1. From the Remote Control Console, click the **Scenarios** tab.

2. Right-click in the scenarios list box and select **Add**.

![Figure 10-7](image)

A new scenario appears in the scenarios list box.
**Configuring Scenarios**

Configure the scenario allows you to set how many times you want the scenario to run, the time delay between each scenario loop and what the device should do at the end of the scenario.

**To configure a scenario:**

1. Right-click the scenario and select **Edit**.

   The *Edit Scenario* dialog box appears.

   ![Edit Scenario](image)

   *Figure 10-8. Editing Scenarios*

2. Enter the **Scenario Name**.

3. In the **Loop Count** text box, enter the number of times you want this scenario to run.

4. In the **Loop Delay** text box, enter the time delay you want between each loop of the scenario.

5. If you want to suspend the device when the scenario completes, enable the **Suspend Device When Complete** option.

6. If you want to reboot the mobile device when the scenario completes, enable the **Reset Device When Complete** option.
7 If you want to disable video updates, enable the Disable Video Update option.

8 Click OK when you are finished.

**Adding Scripts**

You must add at least one script to a scenario to run the scenario.

**NOTE** Scripts can not be run on their own. They must be part of a scenario.

**To add scripts:**

1 Select a scenario from the scenario list box.

2 In the script list box, right-click and select Add.

   The *Edit Script Entry* dialog box appears.

3 From the *Script File* drop-down list, select which script you want to add to this scenario.

4 In the *Loop Count* text box, enter the number of times you want this script to run.

5 In the *Loop Delay* text box, enter the time delay you want between each loop of the script.

6 Click OK when you are finished.
The script is added to the scenario.

7 Continue adding scripts until your scenario is complete. When you are finished, you can run your scenario. For more information about running scenarios, refer to *Executing Scenarios* on page 129.

**Removing Scripts**

If you have a script that you do not want to be part of a scenario, you can remove that script, but keep the rest of the scenario intact.

**To remove a script:**

1 In the Remote Control Console, select the *Scenarios* tab.

2 Select the Scenario that contains the script you want to remove.

3 In the script list box, select the script you want to remove from the scenario.

4 From the *Scripts* menu, select *Delete*.

   The script will be removed from the scenario. The script will remain available for other scenarios unless you remove it from the *Manage Saved Events* dialog box. For more information, refer to *Managing Scripts* on page 128.

**Deleting Scenarios**

When you no longer need a scenario, you can remove that scenario from the list box.

1 In the Remote Control Console, select the *Scenarios* tab.

2 Select the scenario you want to remove.

3 From the *Scenarios* menu, select *Delete*.

   The scenario is deleted.

**Managing Scripts**

You can manage your saved scripts from the *Manage Saved Events* dialog box. This dialog box allows you to view all the scripts you have created and then
delete them if you no longer need them. Once a script is deleted, it is no longer saved in the Recorded_Data folder.

**To delete scripts:**
1. From the Remote Control Console, select the Scenarios tab.
2. From the Scripts menu, select Manage Saved Events.

   The Manage Saved Events dialog box appears.

![Manage Saved Events](image)

**Figure 10-10. Manage Saved Events**

3. Select the script that you want to delete and click **Delete Selected Events**.

   The select script is removed.

**Executing Scenarios**

Once you have completed creating your scenarios, you can run the scenario from the Scripts tab of the Remote Control Viewer.

**To run scripts:**
1. Establish a Remote Control connection session with a mobile device.
2. In the Remote Control Viewer, click the Scripts tab.
3. Select the scenario you want to run on the mobile device and click **Run**.
In the script list box and the device view, you will see the scenario run through each script. When your script is complete, the Status column in the script list box will display Complete.
Chapter 11: Managing Device Skins

Skins display an image of the mobile device on your PC screen. Keymaps allow you to use the image of the mobile device screen just as you would if you were pressing the buttons on the actual device. The keymaps assign specific functions to each key on the virtual image of the mobile device. You can assign the functions that the button would not normally do using a key map. You have the ability to create custom skins and keymaps for any of your mobile devices.

Using the Keymap Editor you can import custom skin images you create for your mobile device. You can then configure Remote Control to automatically detect what type of device you are connecting to and display the associated skin by default.

Using the Keymap Editor you can also create keymaps for the device skins. This allows you to specifically customize the way your mobile device buttons perform in the Remote Control Viewer.

This chapter provides information about the following tasks:

- Accessing the Keymap Editor
- Downloading Skins
- Creating New Skins
- Editing Skins
- Packaging Skins
- Applying Skins
- Toggling Skins

Accessing the Keymap Editor

You can access the Keymap Editor from the software package or from the Remote Control Console. This section provides the following information:

- Accessing the Key Map Editor from the Software Package
- Accessing the Keymap Editor from the Remote Control Console
Accessing the Key Map Editor from the Software Package

You can access the Keymap Editor from a Remote Control software package installed in either Avalanche Manager or Avalanche MC.

To access from Avalanche Manager:

1. In the Tree View of Avalanche Manager, navigate to the software collection in which you installed the Remote Control software package.
2. Right-click the Remote Control software package.
3. Select Configure Package > KeyMap Editor.

The Keymap Editor appears.

To access from Avalanche MC:

1. Select the Remote Control package in the Software Profiles tab and click Configure.

   The Configure Software dialog box appears.
2. From the drop-down menu, select KeyMap Editor.

   The Keymap Editor appears.

Accessing the Keymap Editor from the Remote Control Console

You use the same method to access the Keymap Editor from the Remote Control Console in both Avalanche MC and Avalanche Manager.

To access the Keymap Editor:

1. Access the Remote Control Console.

   For more information about accessing the Remote Control Console, refer to Chapter 4: Launching the Remote Control Console on page 39.
2. From the File menu, select Keymap Editor.

   The Keymap Editor appears.
Chapter 11: Managing Device Skins

Downloading Skins

To reduce the size of the software package, Remote Control is only packaged with a select number of device skins. Remote Control includes a variety of device skins from major manufacturers. If your mobile device skin is not in the list of packaged skins you can create a new skin or you can check the Skin Download Manager on the Wavelink web site. For information about creating new skins, refer to Creating New Skins on page 135.

The Skin Download Manager contains mobile device skins that you can download to the Keymap Editor and use in Remote Control. These skins may be created by Wavelink or other Remote Control users. Users can create skins and then upload skins to the Web site for other people to download. For information about packaging a skin you created and uploading it to the Skin Download Manager, refer to Packaging Skins on page 144.

When you download a skin from the Skin Download Manager, the skins are stored on the Remote Control Server and also appear in the Skins List of the Keymap Editor.

To download skins:

1. From the Skin menu in the Keymap Editor, select Download from Web.

The Skins Download dialog box appears.
2 Click **Connect** or **OK**.

You will connect to the Wavelink Skin Download Manager.
3 Select the skin you want to download and click **OK**.

**NOTE** For each skin, there may be a number of different keyboard configurations. Be sure to select the skin with the keyboard configuration you want to use.

The skins are stored on the Remote Control server and the skin files are downloaded to the `\Skins` folder in the Remote Control installation directory. The skin appears in the Skin list (of the Keymap Editor) marked with an asterisk.

4 Click the skin to display it in the Keymap Editor.

**Importing Skin Files**

Once you download a skin, it is immediately visible to Remote Control, the Remote Control Console and the Keymap Editor. You can open the skin from the list of skins, or you can import the skin files into the Keymap Editor. Skins are saved as `.xml` files.

**To import skin files:**

1 From the **File** menu of the Keymap Editor, select **New** to open the file in a new Keymap Editor.

**NOTE** You can also select **Open** to import the new file into the original `skins.xml` file.

2 Locate the `skin.xml` file that you downloaded from the Skins Download Manager (located in the `\Skins` folder Remote Control installation directory) and click **Open**.

The file is imported into the Keymap Editor. The device name appears in the device list with all associated images and configurations.

**Creating New Skins**

Before you can build and edit a new skin, you must complete the following tasks.
1 Create an image of the mobile device. Using a graphics design program, create an image of the mobile device. This will be the image that appears when you connect to the mobile device and display the skin.

2 Create a down image of the mobile device. Using a graphics design program, create an image of the mobile device when a key is in a down state. The down image can be the same as the main image.

3 Create a key map. Create a key map of the mobile device keys/buttons you want to configure in the Keymap Editor. You will use this map to configure the behavior and actions of key presses in the Remote Control Viewer. Each key/button must use a unique color.

**NOTE** All image files should be saved as .png or .bmp to retain all colors.

After creating the skin images, import each image into the Keymap Editor, configure the mobile device information associated with that skin, and then edit the button actions and behaviors.

This section provides information about the following related tasks:

- Configuring Skin Information
- Importing Images

**Configuring Skin Information**

Create a new skin file before importing skin images. The skin file contains the device information for that specific skin. Remote Control uses this information to auto-detect device types.

You can configure the following types of skin information:

- **Extended Skin.** Extended skins are skins that have configured keymaps. If you are not going to configure a keymap for this skin, do not enable this option.

- **Name.** This is the name of the skin.

- **OEM Info.** This may be the complete OEM string returned by the device or a partial string. Remote Control will match the complete OEM string, returned by the device, with the data entered here. For example, if a device
returns “My Device 3100” and another device returns “My Device 3110”
the OEM String “My Device 31” would match both. This is useful when
similar devices can share the same keyboard information and slight
display differences are not significant.

- **Client Screen** (X and Y coordinates). These coordinates reflect the height
  and width that the skin will display in the *Remote Control Viewer*.

- **Screen Size** (Width and Height). If two similar devices return the same
  OEM but have different screen sizes, you can specify the screen size for the
  skin so that Remote Control will autodetect the correct skin.

**NOTE** A GUID is automatically assigned to the skin. You cannot configure this
information.

To configure skin information:

1. From the **Skins** menu, select **New**.

2. In the device information region, enable the **Extended Skin** option if you
   are creating an extended skin.

3. In the **Name** text box, enter the name of the skin.

4. In the **OEM Info** text box, enter device manufacturer information you
   want the Remote Control auto-detect feature to associate this skin with.

5. In the **X** and **Y** text boxes, enter the pixel height and width of the skin.

6. Click **Apply Changes** to save your changes.
Once you enter information for the mobile device, you are ready to import the images of the device that you have created.

**Importing Images**

Import the images you created of the mobile device into the Keymap Editor. Imported images will be available to display in the Remote Control Viewer when you connect to a mobile device. You can import the following types of images:

- **Normal.** This image is the normal display of the mobile device when it is in a stand-by state. This image displays upon a Remote Control connection to the mobile device.

- **Down.** This image displays the mobile device when a key is in the down state. This image can be the same as the normal image.

- **Map.** This image is the keymap for the mobile device. The image should display all the buttons that you want to configure for the mobile device as a unique color button. You use this map image to configure the action of each key.

As you import each image, Normal, Down and Map tabs appear in the preview region. You can click each tab to display the specific image. When you are finished importing, an Overlay tab appears. Use this tab to compare the Map image to the Normal (actual) image of the mobile device. You can verify that the buttons on the map tab fall into place with the actual buttons on the mobile device.

**To import images:**

1. From the device list, select the device for which you want to import images.

2. Click the [...] button next to the Normal text box.

3. Locate the image file you want to import and click Open.

   The image displays in the Normal tab.

4. Click the [...] button next to the Down text box.

5. Locate the image file you want to import and click Open.

   The image displays in the Down tab.
6 Click the [...] button next to the Map text box.

7 Locate the image file you want to import and click Open.

   The image displays in the Map tab.

8 Click Apply Changes to save your changes.

**Editing Skins**

You can edit existing skins or you can edit the newly imported skin images. This section provides the following information about editing skins:

- Editing Skin Information
- Configuring Keymaps
- Viewing Split Screen

**Editing Skin Information**

The skin file contains the device information for a specific skin. Remote Control uses this information to detect the type of device it is connecting to and then displays the appropriate skin.

For details about the editable skin information options, refer to Configuring Skin Information on page 136.

**To edit skin information:**

1 Select a skin from the Skins list.

**NOTE** If you are creating a new skin, you need to import device images. For information, refer to Creating New Skins on page 135.

2 In the device information region, enable the Extended Skin option if you are creating an extended skin.

3 In the Name text box, enter the name of the skin.
4 In the **OEM Info** text box, enter the device OEM information.

5 In the X and Y text boxes, enter the pixel height and width of the skin display in the *Remote Control Viewer*.

6 Click **Apply Changes** to your changes.

### Configuring Keymaps

The Keymap Editor allows you to configure the actions and behavior of the mobile device keys that display in the *Remote Control Viewer*. Use the Map image to configure the different keys. When you import a Map image, the colors and buttons are automatically loaded into the **Actions Editor** region. For information about importing the Map image, refer to *Importing Images* on page 138.

To configure keymaps, you complete two tasks:

- **Creating Key States**. Set different states that the keys may be in.
- **Configuring Key Actions**. Configure different behaviors for each key in the keymap.

### Creating Key States

Using the functionality of key states, you can create many different actions for each mobile device key. For example, you can configure a key to perform one action in the normal state and a different action when the mobile device is in an ALT-SHIFT state. This allows multiple uses for the same keys. You also have the option of making each key a multi-click key. This means that in one state a key can perform up to four different actions depending on the number of times it is pressed.
To create new device states:

1 In the Actions Editor region, click New.

The New State dialog box appears.

![New State dialog box](image)

**Figure 11-5. New State**

2 Enter a name for the state.

3 Enable the Default option if you want this state to be the default state the keys are in when displayed in the Remote Control Viewer.

4 Enable the Sticky option if you want this to be a sticky key.

A sticky key keeps the mobile device in the state until you manually exit the state.

5 Click OK when you are finished.

The new state appears as a tab in the Actions Editor region.

Configuring Key Actions

You can configure key behavior for each button you created in your keymap for the mobile device skin. You can configure a key to perform one action or you can configure multi-click keys. Multi-click keys can perform up to four different actions depending on the number of times the key is pressed. You can create toggle keys that will alternate the state of the mobile device keys.

To configure key actions:

1 In the Map tab, click the key that you want to configure.

The Edit Key Detail dialog box appears.
2 Enter a **Tooltip** for the key.

The information you enter into the **Tooltip** text box will display in the *Remote Control Viewer* when you move the mouse over that key.

3 Select the tab of the key state in which you are going to configure this key.

4 If you want the key to be a multi-click key, enable the **Multi Click** option.

5 From the **On Click** drop-down list, select the action you want this key to perform on the first click.

You can also enter the code for the action you want the key to perform in the **Code** text box.

6 If you enabled the **Multi Click** option, configure the **On Click 2**, **On Click 3** and **On Click 4** options using the drop-down lists.

You can also enter the code for the action you want the key to perform in the **Code** text boxes.

7 If you want this key to toggle the state of the mobile device, for example, act as the shift key, enable the **Toggle** option.
If you enable the **Toggle** option, enter the state that you want this key to switch to when clicked.

Continue configuring each key in all the states.

When you are finished, click **OK**.

The keys are now assigned to perform the actions you configured.

Click **Apply Changes** to save the key configuration.

**Viewing Split Screen**

The Keymap Editor allows you to split the preview screen. Using the split preview screen, you can view different images of the mobile device skin at the same time. For example, you can view the color map in one screen and the actual device buttons in another.

**To view split screen:**
- From the **View** menu, select **Split Screen**.
Packaging Skins

Only a certain number of skins are included with the Remote Control software package. However, you can access and import many other skins at the Wavelink web site Skins Download Manager. For more information about downloading skins at the Skins Download Manager, refer to Downloading Skins on page 133. Additionally, if you create new skins for mobile devices, you can package the skins and upload them to the Wavelink Web site for other Remote Control users to access.

To package skins:

1 In the Skins list, select the skin you want to send to Wavelink.

2 From the Skin menu, select **Send to Wavelink**.

The **Upload Skins Package to Wavelink** dialog box appears.
3 Enter your name, company and e-mail in the appropriate text boxes.

4 Add any comments about the skin you are sending in the Comments text box.

5 Click OK.

Remote Control packages all the files used to create the selected skin and send the package to Wavelink. Wavelink then posts the skin on the Skins Download Manager allowing other Remote Control users to download it.

Skins display an image of the mobile device on your PC screen. Keymaps allow you to use the image of the mobile device screen just as you would if you were pressing the buttons on the actual device. The keymaps assign specific functions to each key on the virtual image of the mobile device. You can assign the functions that the button would not normally do using a key map. You have the ability to create custom skins and keymaps for any of your mobile devices. For more information, refer to Chapter 11: Managing Device Skins on page 131.

The skins included with the Remote Control are defined in an XML file named skins.xml in the directory where the Remote Control program is run.

This section provides the following information:
• Applying Skins
• Toggling Skins

Applying Skins

You can apply or change a skin from the Remote Control Viewer when you are connected to a mobile device.

**NOTE** You can also apply skins when you create connection profiles. For more information, refer to Chapter 5: Creating Remote Control Connection Profiles on page 41.

To apply a skin while you are connected to a mobile device:

1. From the File menu in the Remote Control Viewer, select Configure.

   The Configure dialog box opens.

   ![Configure dialog box](image)

   **Figure 11-9.** Configure dialog box
2 Enable the Show Skin option.

3 From the Skin drop-down list, select which skin you want to display.

   If you select Autodetect, Remote Control attempts to detect the type of device you are using and apply that skin.

4 Click OK.

   The Configuration Data Changed dialog box appears. This dialog box indicates that you changed something from original profile configuration.

   ![Configuration Data Changed](image)

   **Figure 11-10. Configuration Data Changed**

5 If you want to use the updated changes, but do not want to update the configuration file, select the Use New Configuration option.

6 If you want to use the updated changes and would like to update the configuration file to reflect those changes, select the Use New Configuration and Update config file option.

7 Click OK.

   The selected skin displays in the Remote Control Viewer.

### Toggling Skins

Once you enable the Show Skin option, Remote Control displays the skin for the connected mobile device. You can toggle the skin to display or not display from the Device tab in the Remote Control Viewer.

**To toggle skins:**

1 Select the Device tab in the Remote Control Viewer.
2 From the View menu, select **Toggle Skin**.

-Or-

- Click the **Toggle Skin** icon in the Remote Control Viewer toolbar.
Appendix A: Port Information

The following table provides a list of ports used by Remote Control.

NOTE All ports are inbound ports that must be opened in the firewall.

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
<th>Port Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1900</td>
<td>Remote Control Server</td>
<td>TCP</td>
</tr>
<tr>
<td>1899</td>
<td>Remote Control Server</td>
<td>TCP</td>
</tr>
<tr>
<td>7221</td>
<td>License Server</td>
<td>TCP</td>
</tr>
<tr>
<td>1903</td>
<td>Client Discovery</td>
<td>UDP</td>
</tr>
</tbody>
</table>

Table 2-1. Ports Used
Index

A
activating Remote Control 29, 30
automatically 31
manually 32
adding
new scenarios 120, 125
software collections 24
applying skins 146
auto discover 48
autoscale 109
Avalanche Manager 21
Avalanche MC 23
AVI file 98

B
base licenses 27
binary data 85, 88

C
clearing
client settings 58
log file 96
client requirements 18
client settings 53
clearing 58
configuration options 53
connection 53
from the Console 55
from the mobile device 57
logging 55
password 54
pre-connection 58
closing Remote Control 73
comparing registries 90
configuring
capture methods 47
connection settings 42
key actions 141
keymaps 140
log file 94
logging 46
recording methods 47, 99, 115
refresh rate 106
remote display 45
scenario 121, 126
screen capture method 101
server 63
size of display 109
skin information 136
connecting
auto discover 48
over LAN 48
to a suspended device 75
to mobile devices 71, 72
connection
overview 10
profiles 41
requirements 18
settings 42, 53
copying
files from PC 80
files to PC 80
text 111
creating
key states 140
new folders 80
Registry key values 85
Registry keys 85
script scenarios 120
skins 135
SMS message 75

D
deleting
mobile device files 83
scenarios 124, 128
demo mode 34
device initiated connection 15
device skins 104
device statistics display 113
devices, supported 9
display size 109
distribution 10
document
   assumption 7
   conventions 7
downloading skins 133

E
editing scripts 118
e-mail gateway 66
enabling software package 25
executing scenarios 129
exporting registries 90

F
features 9
File Explorer 78
   copying files 80
   creating folders 80
   deleting files 83
   opening 78
   opening files 82
   running programs 82
   viewing files on PC 82

G
generating scripts 115
GSM modem settings 67

I
importing
   skin images 138
   skins 135
installing
   Avalanche Manager software packages 21
   Avalanche MC software packages 23
   Remote Control 17
   software packages 20
   introduction 7

K
key
   actions 141
   states 140
Keymap Editor 132
keymaps 140
   key actions 141
   key states 140

L
launching
   from Avalanche Manager 39
   from Avalanche MC 39
   Remote Control 39
license activator
   in Avalanche Manager 30
   in Avalanche MC 30
   launching 30
license server 28, 35
licenses 27
   activator 30
   base 27
   demo mode 34
   importing 33
   maintenance 28
   types 27
   verifying 36
log file
   accessing 93
   clearing 96
   configuring 94
   saving 96
   viewing 94
   logging 46, 55
M
maintenance licenses 28
managing saved events 128
mobile device information 97
modifying Registry key values 86, 88

N
notification policy 53

O
opening mobile device files 82
overview 8
  Remote Control client 10
  Remote Control Console 9

P
packaging skins 144
password settings 54
pasting text 111
policy 53
Port Information 149
ports 149
ports, server 69
pre-connect 58
  actions 58
  connection methods 59
  excluding devices 59
Process Manager 92
profiles 41

R
recording
  AVI files 98, 100
  methods 47, 99
  scripts 117
  refresh rate 106
  refreshing the display 108
Registry
  binary data 85, 88
  comparing 90
creating new keys 85
deleting key values 89
exporting 90
key values 85, 86
keys 85
viewing 83
Registry Viewer 83
Remote Control 29
  client requirements 18
  closing 73
  connection profiles 41
  connection requirements 18
distribution 10
  features 9
  installing 17
  launching 39
  licensing 29
  overview 8
  server requirements 17
  system requirements 17
remote display 45
resetting devices 113
running mobile device programs 82

S
saved events 128
scaling the display 109
scenarios
  adding 120, 125
  adding scripts 123, 127
  configuring 121, 126
  creating 120
  deleting 124, 128
  executing 129
  from the connection window 120
  from the console 124
  removing scripts 124, 128
screen captures 47
  methods 101
  performing 101, 104
scripts
   adding 123, 127
   editing scripts 118
   examples 119
   generating scripts 115
   recording 117
   recording methods 115
   removing 124, 128
server
   changing settings 69
   connection settings 63
   requirements 17
   SMS options 65
server settings 63
   connections 63
   e-mail gateway 66
   GSM modem 67
   ports 69
   SMS options 65
skins
   applying 146
   configuring 136
   creating 135
   downloading 133
   editing 139
   importing files 135
   importing images 138
   packaging 144
   show skins 104
   toggling 106, 147
SMS e-mail gateway 66
SMS messages 74
   connect to suspended device 75
   sending 75
   Update Now 76
SMS options 65
software packages
   Avalanche Manager 21
   Avalanche MC 23
   enabling 25
   installing 20
   split screen 143
   standard connection 11
   supported devices 9
   suspending devices 113
   system requirements 17
T
toggling device statistics 113
   toggling skins 106, 147
U
   Update Now 76
V
   video mode 112
   viewing
      device information 97
      files on PC 82
      mobile devices 78
W
   WAN Access VPN, SMS Gateway
   connection 12